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EXECUTIVE SUMMARY

This report is submitted as one deliverable from Delivery Order No. 0004 of Contract
N00600-94-D-0345. This submission is being made in both hardcopy and electronic
format. In addition, the information contained here is also being submitted as an HTML
(Hyper Text Markup Language) document. These submissions constitute the required
deliverable products under the Project Action Request Task Order.

The report consists of the following parts:
e Introduction — an overview of the report,
e Completed Tasks — presentation of task results,

e Conclusions and Recommendations — final conclusions and recommendations
derived from the project tasks, and

e Glossary — a listing of technical terms and their definitions from the report.
The major tasks for the report are listed below:

HyperText Markup Language (HTML) and Standard Generalized Markup
Language (SGML) Software Tool Evaluation. The purpose of this task is to
investigate the viability of selected software tools (particularly public domain and
shareware) supporting HyperText Markup Language (HTML) and Standard Generalized
Markup Language (SGML) for use within the Intelink environment. HTML and SGML
authoring tools as well as conversion tools to/from HTML/SGML and selected word
processing applications will be assessed using a standardized process. The effort will
include the formulation of representative documents and the directions for exercising each
of the tools so as to include the particular HTML and SGML features and characteristics
required in Intelink documents. A set of criteria will be established to characterize each
tool’s overall capability. Candidate criteria include the extent to which the tool provides
valid SGML that can be parsed; the extent to which valid tables and graphics are created,
the number of platforms on which the tool family operates; ease of use; cost; and the
extent to which the SGML attribute feature is supported.

Targeted Issue Analyses for Information Standards. This portion of the task is a high
level survey of a selected group of topics that are supplementary to the main task of
evaluating SGML/HTML tools for use on the Intelink. These questions that this study
addressed are given below:

e What conversion tools should be recommended for mapping one document to
another?

e How are data elements for C31 similar to and different from those in SGML,
i.e. how does C3I tie into Intelink?

e What are the Intel Community’s requirements for compression standards to
work on the Intelink?




e What is the future of graphics in the commercial market for use on the
Internet?

e What are the implications of a secure MOSAIC for Intelink users?

e What are the legal requirements for Freedom of Information and the impact of
these requirements on Intelink?

e What work has already started in the Internet community using Hypertext
Markup Language HTML to add audio and full-motion video to a network
hypertext document that uses HY TIME concepts and principles?

The work for the project was completed during the contract period, and is to be presented
to the client in a debriefing on 13 November, 1995. We believe that this report fulfills the
requirements under the task order, and that the results will allow the cognizant decision
makers to have at their disposal information not previously available on the software
products that have been reviewed.

The sections contained in Chapter 2 of the report correspond to the major tasks that were
accomplished for the project. These sections are:

e SGML Editors

e HTML Editors

e SGML Viewers

e HTML Browsers

e Targeted Issues Analyses for Information Standards

The first four of these sections include a listing of the cognizant software evaluation
criteria, a matrix portrayal summarizing the software evaluations, and the text of the
evaluations for the products. The last section attempts to answer the questions regarding
Information Standards that were proposed in the PAR and given in the Introduction.

The nature of the tasks contained in this project are such that they provide the necessary
information for the client/decision maker to make informed decisions concerning the use
of HTML and SGML tools in a variety of end-user oriented applications. As such, the
majority of the direct conclusions that can be drawn from the work are the results of the
reviews of the products. These results are given in the below listed tables, which are
contained in Chapter 2 and listed in the List of Tables:

e Summary of Evaluations of SGML Editors

e Summary of Evaluations of HTML Editors

e Summary of Evaluations of SGML Viewers
e Summary of Evaluations of HTML Browsers

Two other indirect conclusions from this work can be determined. First, the importance
of developing a precise and repeatable evaluation of the products under review cannot be
overestimated. As the number of products increases beyond the capacity for one single
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individual to perform effectively, we confirmed the requirement to develop a solid
foundation of evaluation criteria for the products. As we continued the work on the
products, these criteria became candidates for change. However, the development of
these criteria early on in the project laid the foundation for conducting not only these
evaluations, but also for any future evaluations that the client may require.

Second, the participants in this project found that time and again, especially with regards
to HTML, the notion of a stable standard is still somewhat of a notion for the future,
rather than the present. The standards that are in place today have in many cases been
determined to be inappropriate in view of the explosive growth of the World Wide Web,
and are in the process of being changed. However, for a variety of reasons that appear to
be both technical and political, the standards and even the proposed standards seem to be
changing at least weekly. In fact, some vendors have taken the necessary steps to put into
place capabilities within their products that would allow customers to download changes
to the product that would keep the product current as to proposed standards. All of this
leads to the following conclusion — If a strict adherence to firmly established standards is
required before the client will consider purchasing an HTML product(s), then accept that
this may be the same as deciding not to purchase any product in the near future. It is our
opinion that standards development in the HTML community will be a continuing issue for
the foreseeable future, as technology combines with user requirements and marketplace
realities to form an unstable standards environment.

The views expressed in this article are those of the author and do not reflect the official policy
or position of the Department of Defense or the U.S. Government
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1. INTRODUCTION

This report is submitted as one deliverable from Delivery Order No. 0004 of Contract
N00600-94-D-0345. This submission is being made in both hardcopy and electronic
format. In addition, the information contained here is also being submitted as an HTML
(Hyper Text Markup Language) document. These submissions constitute the required
deliverable products under the Project Action Request Task Order.

The report consists of the following parts:
o Introduction — an overview of the report,
e Completed Tasks — presentation of task results,

e Conclusions and Recommendations — final conclusions and recommendations
derived from the project tasks, and

e Glossary — a listing of technical terms and their definitions from the report.
The major tasks for the report are listed below:

HyperText Markup Language (HTML) and Standard Generalized Markup
Language (SGML) Software Tool Evaluation. The purpose of this task is to
investigate the viability of selected software tools (particularly public domain and
shareware) supporting HyperText Markup Language (HTML) and Standard Generalized
Markup Language (SGML) for use within the Intelink environment. HTML and SGML
authoring tools as well as conversion tools to/from HTML/SGML and selected word
processing applications will be assessed using a standardized process. The effort will
include the formulation of representative documents and the directions for exercising each
of the tools so as to include the particular HTML and SGML features and characteristics
required in Intelink documents. A set of criteria will be established to characterize each
tool’s overall capability. Candidate criteria include the extent to which the tool provides
valid SGML that can be parsed; the extent to which valid tables and graphics are created,;
the number of platforms on which the tool family operates; ease of use; cost; and the
extent to which the SGML attribute feature is supported.

Targeted Issue Analyses for Information Standards. This portion of the task is a high
level survey of a selected group of topics that are supplementary to the main task of
evaluating SGML/HTML tools for use on the Intelink. These questions that this study
addressed are given below:

e What conversion tools should be recommended for mapping one document to
another?

e How are data elements for C3I similar to and different from those in SGML,
i.e. how does C3I tie into Intelink?

e What are the Intel Community’s requirements for compression standards to
work on the Intelink?




e What is the future of graphics in the commercial market for use on the
Internet?

e What are the implications of a secure MOSAIC for Intelink users?

e What are the legal requirements for Freedom of Information and the impact of
these requirements on Intelink?

e What work has already started in the Internet community using Hypertext
Markup Language HTML to add audio and full-motion video to a network
hypertext document that uses HY TIME concepts and principles?

We believe that this report fulfills the requirements under the task order, and that the
results will allow the cognizant decision makers to have at their disposal information not
previously available on the software products that have been reviewed.

The views expressed in this article are those of the author and do not reflect the official policy
or position of the Department of Defense or the U.S. Government




2. COMPLETED TASKS

The work for the project was completed during the contract period, and is to be presented
to the client in a debriefing on 13 November, 1995. The sections contained in this chapter
correspond to the major tasks that were accomplished for the project. These sections are:

e SGML Editors
e HTML Editors
e SGML Viewers_
e HTML Browsers

e Targeted Issues Analyses for Information Standards

The first four of these sections include a listing of the cognizant software evaluation
criteria, 2 matrix portrayal summarizing the software evaluations, and the text of the
evaluations for the products. The last section attempts to answer the questions regarding
Information Standards that were proposed in the PAR and given in the Introduction.

2.1 SGML Editors

2.1.1 SGML Editor Evaluation Criteria

The criteria given here were developed as a guideline for the evaluators when reviewing
the software products under each section. These criteria were intended to help the
evaluator focus on issues of usability, suitability to task, and cost.

2.1.1.1 Overview

In a brief paragraph describe, in general, the positive and negative points of the software.
Give a brief description of the overall set-up of the software. Is the set-up intuitive or
confusing? Does it have similarities with popular word processors to make acclimation
easier?

2.1.1.2 Ease of Use

2.1.1.2.1 User Friendliness

Does it adhere to the GUI standard operational and functional conventions?
Does it have Scrolling?

Does it have Page Up/Page Down?

Does it resize the Window and Text?

Does it have Menu Bars?

Does the application use meaningful pop-up Error Message Windows?




Does the application save your place on exit via a bookmark capability?

Does the application have a “Go To” command?

Does the software provide a spell-checking function?

Does the software provide foreign language speller/dictionary functions?
Does the software provide a dictionary that can be modified?

Does the software provide a thesaurus?

Does the software provide a grammar-checking function?

Does the software provide an on-line Help Search function?

Does the software provide any type of CBT or step-by-step demonstration of how to
accomplish certain functions?

Does the software provide hypertext help?

Based on work during evaluation of software, is the Help function robust enough to allow
a beginning end-user to use the software easily?

2.1.1.2.2 Basic Editing Tools
Does the software provide an undo function?
Does the software provide cut and paste functions within the document?

Does the software allow cutting and pasting from software that is on the same
platform/operating system, e.g., MS Word or WordPerfect?

Does the software provide a Search (or Find) function?

Does the software provide a Search and Replace function?

2.1.1.2.3 Document Display
When building an SGML document instance, what does the default display look like?
Are the tags present when creating a SGML-formatted document?

Can the document instance be viewed without codes and with styles applied before
printing? (Stmilar to a preview function on a basic word processing system.)

How are the SGML structural elements viewed in the software?

2.1.1.2.4 Styles
Can the software easily adapt FOSI or DSSSL styles?
How are styles applied to a document?

Are styles integrated into the software? Does the software have the ability to bold or
change the font of an element on the screen?

Does the software permit multiple styles to be linked to a document instance?




Does the software allow the style sheet to be modified?

Are mathematical/scientific/dingbat characters available on the software?
2.1.1.3 Tables and Graphics

2.1.1.3.1 Tables
Is there a required/desired spreadsheet software for this software?

Once embedded in the document, can the original spreadsheet software be accessed by
double-clicking on the table?

Can you create tables within the software, i.e., does it have an integrated spreadsheet or
table editor?

Is the process of importing tables arduous?
Does it support only SGML format tables (CALS, J2008 or ATA)?
Does the software create the table in a proprietary, non-SGML standard?

2.1.1.3.2 Graphics

Is there a desired/required graphics package for this software?

What graphic formats does the software accept?

Can the graphic be cropped or just resized by the Editor/Author software?
Briefly describe the process of importing graphics?

Do embedded graphics retain their original format or is there a proprietary format that
usurps it?

How quickly are graphics imported? Is it a matter of a few seconds or up to a minute?

2.1.1.4 SGML Attribute Features Supported

How easy is it to include attributes for elements?

Does the system prompt the user when attributes are required?
Can modifications be made to attributes?

How well are attributes displayed for users?

Can paragraph security attributes be used?

2.1.1.5 SGML Inter-operability

When document instances are created in the software, can they be exported along with the
DTD to other SGML software applications?

Does the software easily import SGML document instances from other applications with
DTDs present?




Can the software easily import DTDs without problem?
Does the software support HTML DTDs?
Are DTDs put into a proprietary format?

2.1.1.6 Auto-tag Capabilities

How much user interaction is required to initiate the conversion?

How much cleanup is necessary on converted documents?

What types of documents can be converted? (ASCII, MS Word, WordPerfect, others?)
Does the converter generate“ accurate SGML code?

Does the system search for an accurate DTD match or must the user indicate which DTD
to use?

How are images dealt with?

Can tables be converted?

2.1.1.7 Platforms
Which platforms (operating systems or hardware) can this software be used on?
Are there any future plans for porting the software to other platforms in the near future?

What are the special needs of the software such as memory or other dependent software?

2.1.1.8 Cost and Technical Support
Are LAN licenses available?
Are there discount prices for purchasing a quantity of licenses?

Are technical support contracts available? What is the cost?

2.1.2 SGML Editor Product Evaluations

Below is listed a rating of the SGML Editors that were evaluated for this project. These
ratings were derived from the actual evaluations of the products, and are given as a guide
to the relative capabilities of the products. These ratings should be used in conjunction
with the actual product evaluations, given later in the report.




Summary of Evaluations of SGML Editors

Overview 3.9 36 33 3.0
User Friendliness ¥k %k Ak ok Ak
Editing Tools ¥ &% R R A G g AAAXK p g St gs
Document Display Yo Yk Fh A A Yok Yok
Styles ~ vtk i Qg g g ik A&
Tables % %%k ik 1A g+ 8+ &
Graphics ¥tk Wik e R S g
SGML Attributes ok Ak X @t g X @ Gk S @t B
SGML %% %% % Y Ak Y Yok Yk
Inter-operability
Auto-tag Capability * % * Wk
Platforms Yo Y e e ¥ e * ¥
Cost & Support e ARt g LR g+ g A A Ak

2.1.2.1 SGML InContext 2 Evaluation

2.1.2.1.1 Overview

InContext 2 from InContext Corp. is a Windows-based application that gives the user an
easy environment in which to create SGML documents. When the DTD is selected, the
skeletal structure of the document is placed on the left side of the screen, in what’s called
the Logical Editor. On the right side of the screen, in the Content Editor, the document
itself is displayed. There are no tags visible in the text display and no arrows to write
within. There is a feel that you are typing on any word processing system. Images and
tables are easy to insert into the Content and Logical editors.

The user cannot add invalid elements in the document, ensuring that all documents created
using InContext 2 have valid SGML structure. DTDs cannot be modified using InContext
2. When the document is saved or opened, InContext 2 will give you a view of system
errors and allow you to modify the document.




2.1.2.1.2 Ease of Use

2.1.2.1.2.1 User Friendliness

InContext 2 uses Graphical User Interface (GUI) as the principle means of interacting with
the user. You can scroll within the document by line or page. When the window is resized,
so is the text. The menu bar and pull-down menus allow quick and easy access to
application elements. You can also easily reopen the last file you were working on via the
historical file list located under the File menu. InContext 2 doesn’t have an autosave
function, but if you close the document without saving it, you will be prompted to save.

The software contains a spell-check function, a French/English dictionary that can be
modified, and a thesaurus. In addition, it also has a grammar-checking function that
catches things like contractions, passive voice, redundant expressions and “informal
style.”

The on-line Help function is somewhat wanting. Although it contains hypertext, it is a
mirror-image of the paper-based InContext 2 user’s guide. It explains the buttons and
some processes, but doesn’t go into sufficient detail to answer questions of a curious
eight-hour user. There is no CBT or step-by-step demonstration, although it does take you
through keyboard clicks. The lack of depth in the Help function sometimes causes more
questions than it answers. When loading a graphic, for example, if it doesn’t fit into the
example given in the help, then the user can be on a goose-chase for answers. The
technical support, however, is superb and the people on the other end are patient and
knowledgeable about the system.

2.1.2.1.2.2 Basic Editing Tools

The undo function will remove elements placed on the Logical Editor or, if the text is
highlighted and deleted, it will bring it back. The system also allows you to cut (copy) and
paste information. In addition to cutting and pasting within the software, you can also cut
and paste from outside applications on the system, such as MS Word and WordPerfect in
the Windows environment. The system also has a search and replace function that enables
the user to search for elements, attributes or text. Depending on the DTD being used,
mathematical, scientific and dingbat characters are available via the entities option under
the Edit menu. The fonts used are Windows fonts as SGML doesn’t recognize format
elements. Foreign languages, similar to mathematical, scientific or dingbat characters must
be allowed within the DTD. A French keyboard can also be used with this software.

2.1.2.1.2.3 Document Display Elements

When building an SGML document, the display is a specific document instance creation
window broken into two parts: the Logical and Content editors. The structure (DTD) of
the document is displayed in the Logical Editor. This lists the elements that comprise the
document. As the user scrolls through the elements of the DTD, the Content Editor on the
right side of the screen also moves reflecting the tag-free areas where text can be typed or
graphics/tables inserted. The ability to enter text without tags makes this application a




simple one with which to work. If, however, you want to view the tags, you can using the
Inline view mode to see the SGML mark-up on any document. In addition, the text can be
displayed without the blocks used to represent each element. When viewing the document
or portion thereof in the Inline view, you can also use different markup tags, from basic
arrowheads to ASCII text with graphics. You can easily change back to the default setting
without SGML tags. Similarly, the Logical Editor, which contains the structural elements
of the DTD, can be changed to show only text names, icons and text names or Inline
(SGML Structure) detail, which will show elements such as #PCDATA.

Elements appropriate for the DTD are easily inserted into the Logical (and thus Content)
Editor. When the document is complete and the user wants to view it in a “what-you-see-
is-what-you-get” format, the system uses the Windows Write application and whichever
style is applied will appear.

2.1.2.1.2.4 Styles

In this software, style sheets are not associated with a specific InContext 2 document.
Instead they are applied to any printed or previewed document. Because of this set-up,
one style sheet can be applied to multiple document instances or multiple style sheets can,
at different times, be applied to one document instance.

InContext 2 has an interactive style sheet editor where existing styles can be modified and
new ones created. The style sheet is based on elements that can be designated with specific
styles by themselves or in the context of how they appear in the document. For example,
you can define a style for a subject under a heading in a memo (heading would be the
parent element of subject) or all subjects, no matter where they appear. SGML documents
created in InContext 2 can be output using FOSI or DSSSL styles.

2.1.2.1.3 Tables and Graphics

2.1.2.1.3.1 Tables

InContext 2 uses Microsoft Excel to create all tables. This allows you to edit and modify
tables. If you are using Microsoft Excel 5.0, InContext recommends you open Excel
before beginning a table editing session. When a table element is inserted, you can double-
click on the table and manipulate it in Excel. Select the Close option under the File menu
in Excel when finished working on the table. A message will open asking if you want to
save the table. Select the Yes option and the table will appear in the Content Editor.

If, however, the table is a very small one and doesn’t take up many cells, only the top line
will appear in the Content Editor. You may also insert a table as a graphic, by following
the instructions for graphic insertion. InContext 2 supports 38784B, 38784C, ATA-100
and J2008 table formats. If the document is moved to a system without Excel, the table
can still be edited, but only using SGML code, which is not recommended for basic users.

The process of accessing Excel and the newly created table takes only a few seconds. If
importing as a graphic, it takes a bit longer due to the necessity of identifying the file,
naming the path, etc.

2-7




2.1.2.1.3.2 Graphics

There is no recommended graphics package for this software, it will support any graphics
application available on Windows and any graphic formats used with the application. Once
graphics are loaded, they remain in the format designated via the external graphics
application. Graphics cannot be cropped or resized in InContext 2 unless it is specified in
the DTD and allowed via the style used.

The process for importing graphics, similar to that for tables, includes choosing the file
from the directory structure and the appropriate graphics application. It is fairly straight-
forward. Once the graphic is found, named and directory paths indicated, the system is
fairly quick in loading it. The graphics tested from several different formats took no more
than several seconds to load. If the graphics application, such as Paint Shop Pro, cannot
read the graphic, an External Application Data message appears in the Content Editor
where the graphic should appear. Save the graphic in another format and try again. If you
double-click on the graphic area in the Content Editor, the application will open and the
graphic will be displayed, where it can be manipulated.

2.1.2.1.4 SGML Attribute Features

In InContext 2, attributes are added to elements by opening the Edit menu and selecting
the Attributes option. You must have a knowledge of the structures used in SGML
documents to include the correct attribute Ids, etc., but they are easy to include.

Elements with attributes in InContext 2 have a small circle next to them in the Logical
Editor. To change, add or modify the element’s attributes, select the Attributes option
from the Edit menu or click on the element with the right mouse button. A dialog box
opens with the element’s name allowing you modify the attributes. When an element is
added, the system will not be proactive and indicate attributes must be given to the
element. However, the system will not save a file if appropriate attributes have not been
added to an element. Modifications can also be made to attributes through the Attributes
dialog box. Attributes can also be searched within the document by using the Find option.

Because InContext 2 allows you to attach attributes to all appropriate elements,
paragraphs can be sectioned to be labeled with specific classification levels and caveat
codes.

2.1.2.1.5 SGML Inter-operability

SGML document instances created in InContext 2 can be exported to other software
applications as long as the DTD is also exported or is in the receiving software
application. The software can import SGML document instance without manipulation as
long as the accompanying DTD and declarations exist in the system or are imported as
well. SGML files from the Internet were imported without problem. If there are errors
either in locating the DTD or in the SGML code, the system lists all the errors allowing
the user to correct the problems.




The software imports DTDs without a problem if they are saved as ASCII text file.
InContext 2 also supports the use of hypertext markup language (HTML) DTDs with
SGML documents.

2.1.2.1.6 Auto-tag Capability

InContext 2 does not have auto-tagging or conversion capability.

2.1.2.1.7 Platforms

InContext 2 operates on any IBM PC or compatible 386 SX or above running Microsoft
Windows version 3.1 or higher. InContext Corp. recommends that a minimum of 4 MB
RAM is required, but 8 RAM is recommended for table editing. Six MB of free hard disk
space is also required (Adobe Acrobat requires an additional 6 MB.) For table editing,
Microsoft Excel Version 4.0 or later is required. (Although InContext works closely with
Excel, it is not included with the purchase of InContext 2.)

There are no near-term plans to port the software to another platform. However, version
2.1 is due out at the beginning of November 1995.

2.1.2.1.8 Cost and Technical Support

There are no LAN licenses available from InContext 2. All licenses are based on
concurrent users.

Cost Information for InContext 2

US $ ' US §

JACT201 1/810 995 796

IACT202 2 to 14/ $20 896 716.8
IACT203 15-29/ $50 846 676.8
IACT204 30-49/ $80 796 636.8
TIACT205 50-99/$100 697 557.6
IACT206 100-199/$100 647 517

IACT207 200+/$100 558 446.4

There are two ways to purchase InContext 2, through InContext Corp. out of Toronto or
through xSoft, a subsidiary of Xerox, out of California. If purchased from InContext
Corp., the software comes with one free year of technical support and updates. The
technicians are very friendly, knowledgeable and helpful.




As mentioned at the beginning of the evaluation, InContext 2 is only an authoring system,
you cannot edit DTDs.

2.1.2.2 ADEPT Editor v5.2 Evaluation

2.1.2.2.1 Overview

ADEPT Editor by ArborText is a user-friendly SGML Editor that offers more advantages
than disadvantages. As long as the default setting is kept on, it ensures that valid SGML
format will be created allowing the document to be exported to other SGML editors or
viewers. It also offers linking and hypertext capabilities to easily access certain elements in
a document. Its main limitations are the restrictions surrounding tables and the lack of GIF
and JPEG graphic format support. ADEPT Editor comes with its own table editor, which
must be used when creating tables. Tables not created using it cannot be manipulated
within the document. The graphic support issue will be laid to rest with v5.4, which was
released as the report was being written. Some aspects of the main window display are
also confusing. This is described in detail below.

ADEPT Editor is part of a three SGML tools made by ArborText. Document Architect
allows a user to write, compile, and test SGML Document Type Definitions (DTDs) and
Formatting Output Specification Instances (FOSIs). ADEPT Publisher is a UNIX-based
software that combines the SGML editor with the ability to print, preview and publish on
CD-ROM SGML documents.

2.1.2.2.2 Ease of Use

2.1.2.2.2.1 User Friendliness

ADEPT Editor is GUI-based and reflects normal user-friendly interface options including
scrolling, pull-down menus, pop-up error messages and the ability to move through the
document a screen at a time. Although the main window can be resized, the toolbar icons
cannot.

The software offers a spell-checking function, and a user-defined dictionary. The ADEPT
Editor command line (under the Preferences option of the Options menu) can be used to
add or delete words to the dictionary file. It can also be used to identify common typos
and their correct spelling. The dtgen command (found within the /adept/bin directory) can
be run to recompile the file after manually editing the dictionary ASCII ATD file. (This
procedure is different than that listed in the documentation.) Foreign language dictionary
functions are available if the foreign language dictionary package is purchased. ADEPT
Editor also offers a thesaurus, but not a grammar-checking function.

The on-line Help system of the software does not offer tutorials or even a search function.
Instead the help has sections dealing with specific areas such as graphics or tables. Help
subjects available are limited. Terminology is not defined and it is difficult to find
information on the function in which you are interested. The hardcopy manuals are more
complete and contain detailed tutorials that are easy to follow. It is recommended that if a




floating UNIX license is purchased for ADEPT Editor, hardcopy or on-line manuals are
available for each user.

When you start a New document, you can select a document type template included with
the software. Once open, the document works as a flexible fill-in-the-blank form
containing pairs of tags.

The software ensures valid SGML structure by checking the context of all markup tags
you add or delete from a document. When the context checker is on, which is the default
setting, the Insert dialog box offers only valid elements and SGML constructs. The
context checker provides an error message if you try to cut or to insert text in any way not
permitted by the DTD. You can turn the checker off, but it could result in invalid SGML
format.

2.1.2.2.2.2 Basic Editing Tools

As with most GUI-based applications, the software offers undo and redo functions. It
continues restoring elements of the document as long as the memory of the system will
allow. However, the undo function will ignore changes to the detail or tag display.
ADEPT Editor also has basic copy, cut and paste functions. In addition to moving text
within the document, ADEPT Editor allows you to copy text from another application
located on the same system.

The software’s search function allows you to search and replace, find next and find words
. or elements. In addition, there is a completeness function that checks the document to
ensure valid SGML format. If any errors are found, the system identifies them and allows
you to correct them.

Within the Edit menu there is an option that allows you to edit a selection as ASCII
SGML. This option is only available if you have selected the Full Menus option from the
Options menu. The selected section of the SGML file or the entire file, is shown as ASCII
text with SGML markup.

ArborText offers an interesting option, the Link To... option that allows a table, id or
entity to be linked to the document. If a table is being inserted, using this command, the
table editor opens to create or edit a table. There is a Link to Graphics option, but it has
been removed in the upcoming version 5.4 and should not be accessible.

Mathematical and scientific characters are available via the Entities menu. When the
Character option is selected, a window opens with an extensive list of mathematical,
scientific and foreign language letters/symbols. These can be entered into the document
simply by placing the cursor in the text, opening the window and double-clicking on the
desired symbol. Although the documentation leads you to believe that there is an Equation
Editor to display equations in tables, it is not available.

2.1.2.2.2.3 Document Display

ADEPT Editor allows the user to hide, show all or show partial tags when writing or
editing an SGML document instance. The display is similar to a word processor when tags




are hidden. The main window is filled with the document being edited. When tags are
shown, they are rectangular boxes with arrows at the appropriate end. The element name
is inside the tag. The software also allows tables and graphics to be shown in full or as
icons. The View menu also offers other options dealing with comments, attributes, text
and file entities.

One of the nice features of ADEPT Editor is the ability to produce a hypertext table of
contents (TOC). The system automatically identifies the sections, topics, subtopics,
appendix, etc., based on SGML markup and displays them as a TOC. HyperTOC also
expands or collapses allowing easy navigation of a large document. A warning is that this
option requires a lot of system space. During our testing, the system went down twice.

A confusing feature of the software is the five blank pull-down menu boxes located below
the toolbar. The boxes are there to provide users with shortcuts allowing them to bypass
the pull-down menus. Unfortunately, there is no thorough explanation of the boxes in the
documentation and because they are context-sensitive lists, they change based on the users
actions. We found them difficult to use. However, for seasoned, advanced users, they
could be a boon.

The Validate Changes options works the same way as the Check Completeness option
discussed above, except that it only checks changes since the document was last saved and
not the file entities referenced in the document.

Three tools that can quickly show you information about your document are the Show ID,
Show Context and DTD Viewer. The Show ID option displays all the unique identifier
attributes that allow you to cross-reference graphics, tables, and entities in other areas of
your document. A message window lists all declared and referenced IDs in your
document, with error, warning, and reference count data. The Show Context provides the
document type structure and the markup that is valid at the caret location. The DTD
Viewer allows you to view the DTD and easily insert valid elements into it.

ADEPT Editor also offers hyperlink capability so you can create, delete and show
hyperlinks. Accessed from the Tools menu after the Full Menus option has been selected
from the Options menu, they are easy to use. In addition, the software has bookmarks and
Quickmarks that can be used to navigate the document. Multiple bookmarks can be
created, but only one Quickmark can exist.

The Preference Menu option, also accessed once full menus are turned on, offers an easy
way to configure the software. Using this menu, you can affect the memory allocation for
“undos,” autosave functions, graphic paths, general menu preferences, as well as the
screen display and view options.

2.1.2.2.2.4 Styles

Styles can be modified two ways: in the styles file or within the document itself. When the
file is modified and saved, the style changes remain. The difficulty is in locating the styles
file. There is not set directory indicated in the documentation. Styles can also be modified
within a document. However, the font modifications, new lines, page breaks, etc., will not
be saved in the style file and are for viewing in ADEPT Editor only. ADEPT Editor adapts




to FOSI style, but not DSSSL. Future versions will support the DSSSL-Lite standard
when it is finalized.

2.1.2.2.3 Tables and Graphics

2.1.2.2.3.1 Tables

Out of the box, ADEPT Editor supports CALS tables and those created with the
ADEPT’s table editor, the only application used to build tables. Once the table editor is
executed, it has its own menus that help you create and modify your table. As long as the
table created is based on the. same CALS criteria, it can be exported to other SGML
software. You can import valid SGML tables, but you cannot edit them unless they are
based on the same CALS criteria used by ADEPT’s table editor.

2.1.2.2.3.2 Graphics

There are two ways to insert a graphic in ADEPT Editor. Usually only one method is
allowed in the document. The easiest is to select the Insert Graphics option from the
Markup menu. A window opens where you can supply the filename location attribute. The
directory where the graphic is located must be the same indicated in the Preference menu.
The second required attribute is the Processor name, which if working on a PC will be
“none.” The UNIX system has an available graphics processor. Although this process is
the easiest, it necessitates that if the SGML document is exported to another system, the
path to the file be changed as well.

The second method involves inserting a graphic as an entity. When the document is
moved, you only need to update the location in the entity.map file. This method, although
it went smoothly during the tutorials, is more involved in the “real world.” When a
graphic is imported as an entity, it has to exist as an entity within the DTD. This can be
done using ArborText’s Document Architect or via ADEPT Editor’s command line. Itis a
much more involved process.

ADEPT Editor supports numerous graphical formats including: EPSOM v1.2 and 2.0,
IslandDraw DRW, PCL image file (4.2 or later), TIFF 5, Paintbrush PCX, and Windows
BMP. Interestingly, it does not support GIF or JPEG formats, both of which are slated to
be supported in the new version 5.4 currently being released. ADEPT Editor v 5.4 will
also support CGM and TIFF formats including CCITT group 4 images.

2.1.2.2.4 SGML Attribute Features

Attributes can be modified within a document via the Markup menu. Modifications,
however, are only active for the current display of the document, and they are not saved.

The software allows all tags, and thus their attributes to be displayed or hidden. You can
also add paragraph security attributes. The names and types of attributes and available
attribute values are determined by the document type definition.




2.1.2.2.5 SGML Inter-operability

ADEPT Editor has shown that it can import SGML documents and ASCII DTDs
developed in other systems without problem. Both file types can be copied easily in to the
system. The DTD must be copied into the correct directory so the system can find it when
needed. Once the DTD is copied into the directory, the document instance based on the
DTD was displayed without error or other problems. If there is something within the DTD
that is unknown to ADEPT Editor, you will receive an error message indicating the line
where the error occurred. You can then take action to resolve the problem if possible.

2.1.2.2.6 Auto-tag Capability
Auto-tagging is not an available feature of ADEPT Editor.

2.1.2.2.7 Platforms

ArborText offers customization of the software and options within the software for a fee.
The customization can include creating dictionaries to ensuring system stability as well as
other customer requests.

ADEPT Editor runs on MS Windows 3.1 and UNIX. The UNIX systems include: Sun-4,
HP9000, DECstation, IBM RS/6000 and SGI Iris. ArborText, Inc. recommends the
following minimum requirements for configuration of Adept Editor on the following
systems:




Recommended Configurations for ADEPT Editor on Select Operating Systems

T
SRR

Windows: 386DX; 25MHz, SMB RAM; 25MB available on hard
drive; 640 x 480 VGA monitor.
Sun-4: SunOS 4.1.1/Solaris 2.2; OpenWindows 3.0; X11R4

or greater; 78MB disk space; 24MB swap space
(additional 2 MB per user), 16 MB RAM (additional 6
MB per user).

HP 9000: ) Series 300/400/700/800 (except 310); HP/UX 7.0.3
or HP/UX 8.0.5; X11R4 or greater; 64MB disk space
(additional 2 MB per user); 24 MB swap space
(additional 6 MB per user); 16 MB RAM.

DEC Series 2000/3000/4000: ULTRIX V4.1; UWS 4.1 or greater; 54 MB disk
space ; 24 MB swap space (additional 2 MB swap per
user); 16 MB RAM (additional 6 MB per user.)

DEC 3000 Alpha AXP: OSF/1 V1.3; X11RS5; 54 MB disk space; 48 MB swap
space (additional 4 MB swap per user); 24 MB RAM
(additional 16 MB per user).

IBM RS/6000: ATIX 3.2 or greater; X11R4 or greater; 54 MB disk
space; 24 MB swap space (additional 2 MB per user);
16 MB RAM (additional 6 MB per user).

SGI Iris/Indigo: IRIX 4.0.1; Window system from SGI; 54 MB disk
space; 24 MB swap space (additional 2 MB per user);
16 MB RAM (additional 6 MB per user).

2.1.2.2.8 Cost and Technical Support

LAN licenses are not available for ADEPT Editor on the PC. However, the UNIX version
is only sold with floating licenses, whether the systems are on a network or not. In future
versions, ArborText is planning to make floating licenses available for PCs as well. Each
user must have his or her own license for the system. Currently, there is no GSA pricing
schedule.

Cost Information for Adept Editor

WindoWs Adept Editor
UNIX-based Adept Editor $2,950 $500




Discount Structure for ADEPT Editor

N
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0-$10,000 None
$10,001 - $40,000 5%

$40,001 - $75,000 10%
$75,001 - $175,000 15%
$175,001 - $350,000 20%
$350,001 - $750,000 25%
More Than $750,00 30%

2.1.2.3 Author/Editor SGML Editor Evaluation

2.1.2.3.1 Overview

Author/Editor (A/E) from SoftQuad Inc. is extremely user friendly and ensures valid
SGML document instances, but it also has fairly severe limitations. Tables or spreadsheets
cannot be manipulated in the document instance. Thus, once inserted (by using a third
party application) the table cannot be changed using MS Excel or another application. In
addition, only Bitmap graphics are accepted in the document instance and importing them
is not an easy process. Perhaps the most limiting aspect is that Rules Builder, another

software product of SoftQuad is necessary if you plan to import or export documents.
Author/Editor uses proprietary rules files instead of DTDs. It is a compilation of the DTD,
the document declaration and the paths of external entities. So, instead of simply
importing a DTD and a document instance into the software, you must use Rules Builder
to compile a rules file if there is not currently a rules file that includes the DTD and
document declaration information.

On the flip side, Author/Editor does have extensive dictionary capabilities offering a
system, user and supplementary dictionaries, some of which can be edited by the user.

In addition to Rules Builder and Author/Editor, SoftQuad Inc., has other SGML products
including Panorama Pro, the only commercial SGML viewer that works in conjunction
with Internet browsers, as well as HoTMetal. Standard and Pro, both HTML editors.
Both of these latter applications were highly rated in this evaluation.




2.1.2.3.2 Ease of Use

2.1.2.3.2.1 User Friendliness

Author/Editor is a GUI-based application that offers scrolling, screen up/down, and resize
capabilities. In addition, there are three dictionaries that can be accessed: a system
dictionary, a user dictionary and a supplementary dictionary. The system allows the
addition of up to 24 different supplementary dictionaries that provide specialized
terminology for specific fields such as law or medicine.

An interesting feature is one that allows the user to target certain words for context
checking by the user. For example, their, they’re and there may be misused and would be
contained in a “stop list.” The software also offers a thesaurus feature.

AJE ships foreign language speller/dictionary features with the software. The location of
this dictionary is specified by the system_dict_path configuration variable. System
dictionaries for a number of languages are also available for A/E. You can specify the
language you want using the spell_checking language configuration variable.

When you select the Check Spelling option, Author/Editor starts spell-checking your
document, using the system dictionary, any applicable supplementary dictionaries, and the
user dictionary. The user dictionary is one developed by the user. Only one user dictionary
can be loaded at a time, but you may switch dictionaries in mid-session. The search path
used when loading dictionaries is specified by the user_dict_path configuration variable.
The default filename of the user dictionary is specified with the user_dict configuration
variable. A/E doesn’t have a grammar-checking function.

The on-line help is not as user friendly as the rest of the software. Unfortunately, once you
open up Help menu, the main menu bar changes and you have no ability to toggle back
and forth to your document. It’s also not very clear which are the hyperlink items. There is
no search function or navigational capability. However, the help information is sufficient
for a beginner. The user is offered an alphabetical index that can be scrolled or the Mark
menu can be used to jump to specific letter.

In spite of the restriction of the on-line help, it does provides numerous tutorials. The
tutorial section shows you how to use Author/Editor to create and edit documents. There
are 11 tutorial sessions, each of which takes from 30 minutes to an hour to complete.
These tutorials assume that you know how to use the Windows windowing environment.
The tutorials include information on attributes, entities, creating tables and using SGML
documents.

2.1.2.3.2.2 Basic Editing Tools

The software provides undo and redo functions as well as basic cut and paste from within
the document and from applications on the system. It also offers a search and replace
function.

Mathematical and scientific characters are available, but limited. ISO character sets are
available if they are obtained through rules files to establish styles files. True type fonts are




available for use when viewing or printing the file, but they will not be saved with the
document. Also, an individual word cannot be changed to a true font, but a whole
paragraph can.

2.1.2.3.2.3 Document Display Elements

When you build an SGML document instance in A/E, there is no default display unless
you choose a rules file. The software allows you to turn the tags that indicate the
structural elements on or off when viewing the document. In addition, styles can be
applied in the main display and the document viewed in a what-you-see-is-what-you-get
format.

2.1.2.3.2.4 Styles

Formatting information is stored by Author/Editor in a styles file. This is a binary file
associated with a rules file, which includes the DTD. The style file loads when you the
rules file with which it is associated is opened. The styles file is updated as the document it
defines is saved. A styles file may also be saved in a test format, which allows it to be
edited or modified with a text editor.

The style of words or characters can be changed within the document by placing the
cursor inside the element’s markup and selecting the Character option from the View
menu.

The software currently cannot adapt FOSI or DSSSL styles, but the next version of
Author/Editor reportedly will include this capability.

2.1.2.3.3 Tables and Graphics

2.1.2.3.3.1 Tables

There is not a required spreadsheet software for Author/Editor. In fact, mathematical data
cannot be manipulated at all in the software. Even if a table is placed into a document, you
cannot access the original program in which it was created by double-clicking it. Basic
tables, without spreadsheet capability can be created in the software.

If the document is already an SGML instance, you could import a table, such as an MS
Excel spreadsheet, using a third party tool.

2.1.2.3.3.2 Graphics

Although, there is not a graphics package associated with the current version of A/E, the
next version will reportedly include graphics capability. The only graphic format that is
currently accepted by the software is BMP (Bitmap) format. Graphics can be resized in the
software and retain their original dimensions.

Importing graphics is a tricky process and can cause problems with tables (elsewhere in
the instance), if the user is not careful or does know the exacts steps to be taken when




performing the import procedures. Once the steps are taken to import the graphic it takes
only seconds to load it into the document.

2.1.2.3.4 SGML Attribute Features Supported

The system prompts users when attributes are required for an element. Some elements
also have a list of attributes associated with them. If you insert an element with required
attributes Author/Editor opens a dialog box where the attribute values can be entered. If
“Include Required Elements” is turned on, and an element which is being inserted has a
required attribute and a required sub-element, Author/Editor will ask you whether you
wish to stop and edit the attributes or continue and insert the required sub-element. If you
choose to edit the attributes, you will have to go back and insert the required sub-element.

Attribute values can also be modified, inserted or changed using the Edit Attributes option
in the Markup menu. This open opens a dialog box containing a line for each attribute of
the current element. The attribute value may be text (which could be subject to restrictions
such as the length of the text or first character in the text), an entity, or a selection from a
list of values.

There are a number of ways of easily determining whether an element has attributes and
what the attribute values are. If you place the cursor inside an element, open the Markup
menu and the Edit Attributes option is accessible, the element has attributes. The Show
Context Window option of the View menu also reveals attribute values for selected
elements. You can also show all attributes for the document instance in the main window.

Security attributes can also be used in Author/Editor. Paragraphs may be marked with
special attributes, such as classifications, so they will not be revealed to a user without the
required clearance.

2.1.2.3.5 SGML Inter-operability

The software can import DTDs and SGML documents without a problem. However, the
software compiles the DTD with SoftQuad Rules Builder turning it into a binary format
that can be read by Author/Editor. The rules file contains the same information as the
DTD, but in a different format. When a file is imported, Author/Editor uses the
information in the document type declaration and in an auxiliary file called the “external
identifier map” to find the correct rules file. The software also supports HTML DTDs,
however, this would also be combined into a rules file.

When documents are created in Author/Editor, they can be exported to other SGML
software applications. However, while A/E uses Rules Builder to compile the rules file
necessary for creating a document instance, no other SGML editors use this same
configuration. Therefore, prior to exporting the document, you must locate the original
DTD the rules file is based on and export that with the document, not the rules file. In
addition, some rules files contain information such as the location of external entities.
These paths must also be included in the new document’s declaration.




In the same way, Author/Editor can import valid SGML document instances as long as the
DTD it is based on is compiled into a rules file by SoftQuad’s Rules Builder software.
There are numerous rules files that come with the software.

2.1.2.3.6 Auto-tag Capability

Author/Editor does not have the capability to convert a word processing or ASCII file
into SGML format.

2.1.2.3.7 Platforms

SoftQuad’s Author/Editor runs on Microsoft Windows, Macintosh and UNIX platforms.
The UNIX operating systems include Sun OS 4, Solaris 2.3, HP-UX, IBM RS6000 or
DEC Alpha, and use only Motif Windows. At a minimum, the platforms need to meet the
following criteria:

System Requirement Information for Author/Editor

Macintosh 8 MB RAM,; System 7 or higher
DEC Alpha AXP Series 3000, 48 MB RAM, OSF 1 Version 2.0
HP 9000 Series 700, 16 MB RAM
Sun OS4/Solaris 2.3 16 MB RAM
IBM RS6000 Series 300 or 500 , AIX Operating 3.2.5,16 MB RAM

2.1.2.3.8 Cost

SoftQuad does not offer a LAN license for Author/Editor, nor is there a GSA price
structure. There are discounts, however, for quantity purchases. Technical support is also
available. Prices are based on those received September/October 1995.
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Cost Information for Author/Editor

1-4 copies 5995 $1905
5-9 copies $796 $1596
10-49 copies $700 $1396.50
50-99 copies $646.75 $1296.75
100+ copies $597 $1197
Technical Support per license $149 $299.25

2.1.2.4 Microsoft SGML Author Evaluation

2.1.2.4.1 Overview

Microsoft SGML Author is user-friendly in that it emulates many elements of MS Word.
However, as an SGML application, it is complex and cumbersome. It is an add-on tool to
MS Word 6.0, allowing you to save documents in SGML format. Microsoft
documentation states that MS Author is for expert users of Word and SGML and it’s true.
Our evaluation revealed that once understood the software is not difficult to use. The
understanding, however, can take hours. This system is not for the basic or beginning
SGML user. In spite of the MS Word similiarities, MS Author requires that the user have
in-dept knowledge of SGML elements and confidence working with complex software.

SGML Author converts Word documents into SGML format by creating the files that
store the relationship between Word constructs and SGML elements. The converter uses
this file when a Word document is saved as SGML and vice versa. Author creates
documents in Word, using templates that match the SGML document type definition
(DTDs) you want to use. The difficulty is creating these templates. An association file
must be built to map the relationships between MS Word and SGML elements. Although
MS Author allows files to be moved from MS Word to SGML formats, it is at a price.
Most SGML editors use DTDs that can be moved from one SGML editor to another
without complex manipulation or “mapping.” For documents created in MS Author, the
DTD would have to exist and be moved with the document if used on another system in
addition to the association file being created for MS Author.

2.1.2.4.2 Ease of Use

2.1.2.4.2.1 User Friendliness

MS Author is an exceptionally user-friendly program because of its close relation with MS
Word. It has a very familiar appearance and feel to most Windows users. Since it is used
in conjunction with MS Word, familiarity with MS products is a plus.
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1t adheres to the generally accepted operational and functional conventions of GUI, and it
supports the page up/page down and resize window and text. The menu bars are
conventional within the MS standards. The pop-up Error Msg Windows display error
messages that are clear if you have solved the problem once before, but cryptic and terse if
this is the first time you have encountered the error.

Bookmarks are used by MS Author, but if more than one bookmark is used in a paragraph
only the first one will be converted and saved. In addition, if the bookmark spans more
than one paragraph, the end of the bookmark will be lost during conversion. MS Author
assumes that the bookmark is for the first paragraph only.

Since MS Author is used in.conjunction with MS Word, it has all the spell-check and
foreign language capabilities that MS Word offers. The spell-check is quite extensive and
there are numerous foreign language versions available. MS Word dictionary, thesaurus,
and grammar checking features are also available for MS Author.

There is an on-line help that is similar to the pop-up error messages. It is helpful to a
“second” time user, but is not clear for the first time problem solution.

Before an SGML document instance can be created in MS Author, the user must know
how to create a DCL file that clarifies the document type definition (DTD) as well as build
an association file that is used to map directly to SGML tags. The association file includes
“descriptors” for styles within MS Word. The bottom line is that the elements that make
this applictaion user-friendly, i.e., its reliance on MS Word, also make it more difficult
and more complicated than many other SGML editing applictaions reviewed.

2.1.2.4.2.2 Basic Editing Tools

Since the software simply maps the text from Microsoft Word, you have access to all the
editing functions in MS Word. These functions include undo, cut, paste, copy, search, and
replace. All the text can be treated as if it were in a word processing package. Text can be
modified or labeled with a new descriptor.

2.1.2.4.2.3 Document Display

When converting to an SGML document instance, the display is quite clear. All options
are displayed and if there is a discrepancy with a descriptor, a message will point out the
element in question. There is a toggle function that allows you to display or hide the
SGML structural elements. These elements are also referred to as tags. This is helpful
when you wish to modify a descriptor or edit some text.

2.1.2.4.2.4 Styles

Because MS Author’s works closely with MS Word, it supports “styles” used in MS
Word, not the SGML community standard FOSI and DSSSL formats. This can cause
problems for inter-operability with other SGML editors. MS Author does not provide for
output other than an SGML compliant file or an MS Word file. It can, however, output
SGML files to a viewer or print production program.
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Styles such as bolding and italics can be done via MS Word, but it will not translate into
SGML.

There is only one descriptor option for an equation, the “Equation descriptor.” The
ISO/ECI TR 9573-11:1992(E) tag set for equations must be used for all equations as the
other tag sets will be converted into comments. You do not have to associate the
equation but you are required to specify whether it should be an ISO tagged equation or a
picture when you convert the image to SGML.

2.1.2.4.3 Tables and Graphics

2.1.2.4.3.1 Tables

The one descriptor for tables is referred to as the Table descriptor. This descriptor only
supports the table model created for CALS (Continuous Acquisition and Life-cycle
Support). When converting, you do not have to associate the table because by default, the
table will automatically be converted to a CALS table in the SGML instance. The CALS
table consists of a title and a collection of groups. Each group can have a heading and/or a
body. You have the option to specify the width of each column and number of cells.

Located in Appendix A of the System Administrator’s Guide, there is a table that lists the
CALS table elements and associated attributes. This appendix also provides information
on how to convert from SGML to Word and from Word to SGML. Attributes for table
borders are also listed with import and export information.

2.1.2.4.3.2 Graphics

Just as text styles need descriptors, objects need descriptors as well. An object can be
defined as a graphic or an Object Linking and Embedding (OLE). When allotting room for
an object in your document, SGML Author automatically creates a default descriptor as
Unmarked Picture. You do not have the ability to rename the Unmarked Picture but you
do have the ability to edit the descriptor. You do have the option of customizing the
object descriptors in order to distinguish between various graphics (illustrations, charts,
tables, etc.).

The three different types of objects are unlinked graphics, linked graphics and OLEs. The
unlinked graphics are pasted into the document from the clipboard and basically treated as
a text descriptor. If you need to edit the graphic, you can double-click on the item,
converting it to an OLE. Both text and graphics can be linked to an external executable
source. Even though the graphic is linked to another location, you have the ability to copy
the image to visually see the graphic in the document. The two parts of the OLE objects
are the binary representation of the graphic and a Windows metafile of the picture. A
graphic from Microsoft Excel could be used as an OLE object and edited in Excel when

necessary.
During the conversion process, you can save the graphic in its original file format, a

Windows Metafile (WMF), or a Computer Graphics Metafile (CGM). When linked, the
file should be saved with the extension of ' WMF, .CGM, or .OLE.
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2.1.2.4.4 SGML Attribute Features Supported

The Converter uses “Private” fields in a Word document to store attributes . A
“Private” field is one used by Word to store information not appearing in the document.
There are a number of methods by which a “Private” filed can be created within Word.
The Converter inserts the “Private” field at the start of the paragraph or character style.
To be recognized by the converter, a “Private” field must be within the style associated
with the element for which it specifies attribute values. An author can insert a “Private”
field anywhere as long as it is marked by the appropriate style.

The system prompts the user if the “descriptor” has been associated with an attribute or
an element that has attributes. The prompt is an attributes button. When you click on the
attributes button, the Simple Attributes dialog box appears so you can specify attribute
values. If you have associated the descriptor with an element, all attributes of the element
are displayed. If you have associated the descriptor with an attribute, the attribute is
displayed, along with the other attributes of the same parent element.

Modifications may be made to attributes easily. As mentioned earlier MS Author uses a
drop down menu from the “Attributes Button” to assign attribute values.

The addition or modification of possible selections to the list is made by typing the value in
the space provided. If you have set a default value for the attribute, that value is
displayed. You can type over it to supply an explicit value for the attribute.

Attributes are displayed readily for users. When you click on the “Attributes Button,” the
Attributes Dialog Box appears so you can specify attributes values. If you have associated
the descriptor with an element, all attributes of the elements are displayed. If you have
associated the descriptor with an attribute, the attribute is displayed. along with other
attributes of the same parent element.

The paragraph security attributes are easily used. An example of a “Private” field would
be:
{PRIVATE SGML GI “PARA” Security = “TS”}

A big problem with the Editor is that there is no SGML validation capability. When
writing a document, it is possible to create invalid SGML code. When the document
instance is saved, an error message will appear, but without in-depth knowledge of both
MS Author and SGML elements, it is almost impossible to correct the problem.

2.1.2.4.5 SGML Inter-operability

This software has the functionality to import and export text and attributes as SGML
tagged information. However, because it uses the association file to map elements, it does
take some work to move document instances from one application that uses only the
DTD, such as InContext to MS Author, which must have an association file and DCL file.

The Import Options dialog window allows you to clarify and select a default character
style and paragraph style. There are two basic strategies used for specifying default styles
when you’re importing SGML into Word. The first approach ensures that the text is
converted with minimal impact by selecting a default font and paragraph style as Normal.
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The second approach highlights the content of the unknown element in the Word
document by selecting a special font or paragraph style. This will enable you to visibly
notice the groupings of text that are unknown elements from the conversion.

2.1.2.4.6 Auto-Tag Conversion

Conversion is the reason MS SMGL Author was created. However, because it calls for an
association file and a DCL file, it is a complext process. Average users without significant
SGML and DTD experience will find it very difficult to create the required association
files.

2.1.2.4.7 Platforms

The company recommends that the software should be run on an industry-standard
computer with a 80386 or compatible microprocessor (25 Mhz), or greater. Microsoft
Windows version 3.1 or later should also be available. The system should also have 16M
of free disk space and at least 6M of RAM, although 8M is recommended.

2.1.2.4.8 Cost and Technical Support

The product is available from Microsoft at a retail price of $599.00 per copy. Itis
available through a number of vendors on the GSA schedule. Softmart offers MS Author
on the GSA schedule for $528.00 per copy. Quantity discounts are also available.

Neither Microsoft, nor Softmart could unequivocally report that this product was
available with a LAN license. You may create disk images on a network server so your
authors can install SGML Author over the network.

Microsoft stated that this product was sold via the GSA schedule and secondary vendors
such as Egghead Software or Softmart.

The Softmart representative said that volume discounts would be available, however she
could not quote specifics without an RFQ.

This product has no special Tech Support requirements nor does it have support beyond
the normal Microsoft help phone lines. The software is designed to be used in conjunction
with MS Word.

2.2 HTML Editors

2.2.1 HTML Editor Evaluation Criteria

The criteria given here were developed as a guideline for the evaluators when reviewing
the software products under each section. These criteria were intended to help the
evaluator focus on issues of usability, suitability to task, and cost.
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2.2.1.1 Overview

In a brief paragraph describe, in general, the positive and negative points of the software.
Give a brief description of the overall set-up of the software. Is the set-up intuitive or
confusing? Does it have similarities with popular word processors to make acclimation
easier?

2.2.1.2 Ease of Use

2.2.1.2.1 User Friendliness

Does it adhere to the GUI standard operational and functional conventions?
Does it have Scrolling?

Does it have Page Up/Page Down?

Does it Resize the Window and Text?

Does it have Menu Bars?

Does the application use meaningful pop-up Error Message Windows?
Does the application save your place on exit via a bookmark capability?
Does the application have a Go To command?

Does the software provide a spell-checking function?

Does the software provide a dictionary that can be modified?

Does the software provide on-line Help Search function?

Does the software offer autosave function?

Is there hypertext help options?

Does the software provide any type of CBT or step-by-step demonstration of how to
accomplish certain functions?

2.2.1.2.2 Basic Editing Tools
Is there a tool bar showing routine and non-routine tags as icons?

When the cursor is placed over an icon on the tool bar, if they exist, are text descriptions
available?

Are key combinations available for commonly used tags?
Does the software provide an undo or redo function?
Does the software provide cut and paste functions within the document?

Does the software allow cutting and pasting from software that is on the same
platform/operating system, e.g., MS Word or WordPerfect?

Does the software provide a Search (or Find) function?
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Does the software provide a Search and Replace function?

Are mathematical/scientific/dingbat characters available on the software?
Does the software support foreign languages?

Does the software provide HTML syntax checking as an option?

What document types can be imported into HTML?

2.2.1.2.3 Document Display

When building an HTML document, what does the display look like? Is it based on logical
representation or multiple windows?

How are HTML elements graphically represented in the display?
Is there a distinguishing element between begin and end tags?

Can the document be viewed without codes and with styles applied without being sent to a
browser?

2.2.1.2.4 Styles

Can words or sections have a style attributed to them (Bold, Italics, etc.)?

In what format are styles saved?

Does the software have an interactive style sheet editor?

Does the software allow the style sheet to be modified?

Can style sheets be copied into a directory for use? Is the directory name specified?
Does the software come with default style sheets?

What elements of style can be set by the system?
2.2.1.3 Tables and Graphics

2.2.1.3.1 Tables
Are SGML tables supported? (This is part of the HTML 3.0 standard.)
Can tables be cut-and-pasted into the HTML document?

2.2.1.3.2 Graphics

Can you see graphics in the HTML software display when creating a HTML document?
What graphic formats does the HTML software support?

Can graphics be resized easily within the software?

How are graphics imported? Does this involve multiple windows or is a matter of two or
less commands?
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Can you designate a certain portion of an image to be connected to another location
within or outside the document, called image mapping?

2.2.1.4 HTML Attribute Features Supported
Are HTML Version 2.0 elements supported?
Are any elements of HTML 3.0 as it currently exists supported?

Is there an SGML editing component that ensures the elements of the HTML DTD are
valid?

If yes, is the editing component context sensitive?
Can you define attributes for elements in the system?
Can you create Ordered Lists?

Can you create Unordered Lists?

Can you create Definition Lists?

Can you create Check Boxes?

Can you create Radio Buttons?

Can you create Action Buttons (Reset/Submit)?

Can you create Lists of Choices?

Can you create Text Boxes?

Can you create mailto ability through a browser?

Is the process of creating such elements straight forward? Explain with specific examples.

When creating elements with many sub-elements such as Ordered Lists that include List
Items and Text, do you have to select List Item and Text each time, or does the system
know that text will follow the list item?

How are Anchors designated?

2.2.1.5 Platforms

When is the next planned upgrade?

Which platforms (operating systems/hardware) can this software be used on?

Are there any future plans for porting the software to other platforms in the near future?

What are the memory needs of the software?

2.2.1.6 Cost and Technical Support
Are LAN licenses available?

Are there pricing discounts for quantity purchases?

2-28




Are technical support contracts available? If so, what is the cost?

2.2.2 HTML Editor Product Evaluations

Below is listed a rating of the HTML Editors that were evaluated for this project. These
ratings were derived from the actual evaluations of the products, and are given as a guide
to the relative capabilities of the products. These ratings should be used in conjunction

with the actual product evaluations, given later in the report.

User Friendliness
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HTML Attribute
Features

Platforms
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2.2.2.1.1 Overview

HotDog offers features such as function keys that allow easy creation of a form, table or
inserting an image. However, the system leaves it up to the user to police the validity of
their HTML coding. If offers no structures or constraints on the user, leaving open the
possibility of creating an invalid home page or document. There is also a more robust
Professional version of HotDog that was not evaluated for this project. Sausage Software,
the maker of HotDog, is based in Australia, making communication difficult.

2.2.2.1 HotDog HTML
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2.2.2.1.2 Ease of Use

2.2.2.1.2.1 User Friendliness

HotDog uses basic GUI standards including scrolling, screen up or down and menu bars.
In addition, the software offers toolbar icons for basic editing functions.

The system does offer an autosave function, but there are no spelling, dictionary or
thesaurus functions.

The help is hypertext based and does offer a search function as well as various tutorials
both on the system and the basics of HTML. In addition, the help includes information on
HTML 2.0 standards, those associated with Netscape and reference to other information.

2.2.2.1.2.2 Basic Editing Tools

HotDog offers a mix of toolbar icons. The smaller ones are used for basic editing
functions. The larger icons allow the user to work within a functional area, such as forms,
tables, images, publishing, fonts or Internet capabilities.

When the cursor is passed over the smaller or larger icons, a descriptive text tag appears.
In addition to the icons, key combinations are available for commonly used tags.

The system offers a basic undo function as well as basic cut and paste functions from
within the document and system. The search functions will search on text, but not on
elements within the document.

Various foreign language characters are available on the system, but they are limited.

The biggest downside of the software is that it will allow the user to create invalid HTML
code. Not only will it allow you to create it, but you can save an invalid form without
having any error messages in obviously incorrect code. HotDog will also not convert a
word processing file into HTML format.

2.2.2.1.2.3 Document Display

The display uses the main window for creating and editing documents. HTML elements
are displayed within less than (<) or more than (>) signs. The end tags have a forward
slash before the element’s name. The difficulty is that when an element is inserted into an
area, only the begin tag is included, not the end tag.

The document can only be viewed without codes via a browser. Within HotDog, there are
not alternative viewing methods.

2.2.2.1.2.4 Styles

Style elements can be applied to words or sections of text, and are saved within the file.
There is no generic style directory or style sheets available through HotDog.
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2.2.2.1.3 Tables and Graphics

2.2.2.1.3.1 Tables

Tables are supported by HotDog, but they must be created within the software. Creating a
table is easy. The user only has to click on an icon in the toolbar. When the table window
opens, the user can define what elements they want used. Tables cannot be cut and pasted
from Excel or other spreadsheet application.

2.2.2.1.3.2 Graphics

Graphics are viewed via the browser hooked up to the software. Once a browser is
selected, one of the icon buttons changes to the browser icon. This is a nice feature as the
HTML document can be easily viewed. GIF graphics are supported without external
applications, but others need to have the application designated.

Importing graphics, whether from a file on the system containing GIF graphics or using an
external application, is not an onerous process. Once the user clicks on the image icon, a
window opens. From this one window, the user can search for the specific file or attach
the external application. Graphics can also be resized using the graphic window.

Image maps can be created in HotDog. These allow you to connect a certain area of an
image to a file. The process involved is fairly direct.

2.2.2.1.4 HTML Attribute Features Support

HotDog supports HTML version 2.0 standards and some HTML 3.0, such as tables. It
also supports some Netscape elements.

As mentioned above, the software does not have a SGML/HTML editing component to
ensure that the DTD is valid. In fact, the system allows you to insert elements in known
invalid locations and to save the file without any rules checking capability. This is a huge
deficit of the product.

The software does offer numerous elements for the user to create. These include ordered,
unordered, definition, directory and menu lists. Because of the large function icon buttons,
you can easily create forms with everything from submit buttons to check boxes, radio
buttons and text areas. You can also use the mailto function using the Internet icon.

To create an element, you simply have to click on the desired element on the toolbar or
open the function window and select an element from there. Once the element is inserted,
however, the system doesn’t add a list item element after the ordered list element. It will
let you type without any warning or error message. The list item must be selected from a
pull-down menu.

As with other elements of HotDog, there is not a lot of user support available when novice
users are creating links. The on-line help does define the fields in the anchor/link window,
but it is up to the user to use the hit-or-miss method.
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2.2.2.1.5 Platforms

HotDog Standard is available on Windows and Windows NT. The 16-bit Windows
version is now available with a 32-bit Windows version on the way. There is not
information on any planned updates or porting to other platforms. Memory and system
information is also not available.

2.2.2.1.6 Cost and Technical Support

The price per license is US $29.95. Support for each license is $25.00 per year. During the
evaluation, we were unsuccessful in getting a response from Sausage Software. It is
uncertain whether responsiveness would improve for licensed users.

2.2.2.2 HoTMetal v 1.0 (Freeware)

2.2.2.2.1 Overview

HoTMetaL 1.0 is freeware available from the Internet at ftp://ftp.ncsa.uiuc.edu/ Web/html/
hotmetal/Windows. It offers a rougher, less complete and helpful version of it’s
commercial cousin, HoTMetaL Pro 2.0. One problem is that it will allow you to create
invalid HTML documents. However, when you save the file, it will indicate it’s incorrect,
but not how it’s incorrect.

A new freeware version, 2.0, is to be released in November 1995. SoftQuad reports that
the new version will have a new user interface, reduce memory needs and the ability to
edit tables. If these changes are made, it could address many of the concerns identified in
this evaluation.

To install HoTMetaL 1.0 and get it running is not a job for an Internet beginner.
Downloading the software is not a problem, but changing the default files for the browser
to be used and graphics system to support the preview function is not as easy as the
instructions make it seem for a non-technical person. In the same way, using HoTMetaL is
not for an uninitiated HTML user. It allows users to select invalid HTML codes without
an error messages or waming.

Although it prompts you as to what should be your first choice when creating an HTML
document, it will let you choose the wrong element.

2.2.2.2.2 Ease of Use

2.2.2.2.2.1 User Friendliness

HoTMetalL 1.0 does adhere to GUI standards. It offers pull-down menus that reflect those
used on most popular word processors. This includes scrolling, page up/down capability
and error messages. It does not offer bookmark options or a resizing capability that
proportions the page. In addition, because it is the freeware version, there is no spell-
checking or user-modifiable dictionaries.
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A formatted (or non-formatted) version of the help manual is available from the location
where the software is downloaded. We recommend that it is downloaded at the same time
to save problems. The ASCII version can be viewed by most word processors. The help
manual can also be viewed using the browser. On-line, there is a tutorial, that offers
hypertext help options. The tutorial is based on the documentation used with HoTMetalL
Pro 2.0. The software documentation it is very good, leaving the user confused only once
in the tutorial when a step was skipped.

2.2.2.2.2.2 Basic Editing Tools

The freeware version of HoTMetal does not offer a toolbar for routine tags. Some key
combinations are available for commands, but in the case of tags, the key combination
(ctrl-I) only opens the Insert Element Window, from which an element can be selected.

The software does offer an undo/redo function that serves to change tagging actions or
deletions. It also offers basic cut and paste functions from within the document and from
outside text sources on the same platform.

The find and replace function on the software is basic dealing only with words, not
elements or attributes, although it can search backwards.

Surprisingly, for such a bare-bones sofiware, HoTMetaL 1.0 does offer a wide variety of

special characters from mathematical, scientific and foreign language sources. However, it
does not “support” foreign languages in the ways that some SGML editors offer language
packages with dictionaries and grammar checkers.

The software provides HTML syntax checking, but it is not a constant companion to the
user. It kicks in when a file is opened or saved, at which time it will inform the user that
the document does or doesn’t have valid HTML syntax. To aid, the software does come
with several templates that can be used to create forms or home pages on the web. Only
.htm files with valid syntax can be opened by the software. The software would not
convert or even read MS Word or WordPerfect files into HTML.

2.2.2.2.2.3 Document Display

When building, modifying or editing an HTML document, the display uses tags with
arrows. The end tags have a back-slash included to indicate it is the end of the tag. All text
and elements are surrounded by the tags. The document can be viewed without the tags
and with images displayed or it can be previewed in the browser.

2.2.2.2.2.4 Styles

Words and sections of text can have basic styles attributed to them such as bold, emphasis,
italics, etc. These style elements are included under the Surround, Character or Insert
Element options of the Markup menu. Style sheets are saved in a Style directory under the
HoTMetalL directory and the software comes with two of them. They can be applied to
documents, but the browser where the document is displayed will ultimately determine
how the document looks.
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2.2.2.2.3 Tables and Graphics

2.2.2.2.3.1 Tables

Tables are not supported in HoTMetaL 1.0. The elements are included in the Insert
Element Window, but in parenthesis, the user is advised not to use any of the elements.
SoftQuad indicated that in a future release they will be supported.

2.2.2.2.3.2 Graphics

Graphics can be viewed or hidden using HoTMetaL 1.0. The graphic formats supported
include GIF, JPG and BMP. (The user must indicate the application to support each of
these formats in the HoTMetaL 1.0 director under the sqhm.ini file.) You can link images
to other areas of the document, but you cannot link a portion of an image, known as
image mapping, to a location in the document.

Importing graphics is a fairly direct operation. After inserting a graphic (image) element,
simply place the cursor between the tags and select the Edit SGML attributes option under
the Markup menu. When the window opens, enter the directory/file path for the
graphic.(file:///c|/hotmet1/file-name)

2.2.2.2.4 HTML Attribute Features Supported

HTML Version 2.0 standards are supported by HoTMetaL version 1.0. Tables, however,
an element of the new, yet defined HTML 3.0 standards are not supported.

As mentioned above, although the software doesn’t limit the user’s choices when selecting
elements to insert into the document, it does have a HTML DTD rules checker that goes
into effect when a file is saved or opened and will indicate there is an error in the
document. The editing component is not context sensitive. In some instances it will limit
what elements you can include, for example, if you insert a definition list tag, only
definition text and definition term are available. However, it does not offer limited choices
for Ordered Lists or when you initially open a new file.

Attributes can be defined by the system, but in part they are included in the insert element
list.

HoTMetaL Version 1.0 offers almost all the same elements that are available from
HoTMetal Pro 2.0. The difference is the way that the elements are accessed. In the
freeware version, each element must be selected from a window. There are no icons or hot
keys that can be used. The elements include the following: Ordered Lists, Unordered
Lists, Definition Lists, Forms, Text boxes, Text areas, Check Boxes, Radio buttons and
action buttons.

The software doesn’t keep up with the user’s actions. Each element must be manually
inserted unlike some commercial applications.

Anchors are fairly straightforward. The tutorial takes the user through making anchors
step-by-step. Forms can also be created to collect information. The software also allows
you to publish documents on the Internet.
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Files from HoTMetaL 1.0 can be exported in ASCII with the .asc extension or HTML
(-htm) format.

2.2.2.2.5 Platforms

HoTMetaL 1.0 is to be updated and available from various web sites in November. It is
currently running on MS-Windows and Sun OS platforms. The Macintosh version is due
out at the end of 1995. Porting to HP-UX and for Digital UNIX machines is also planned
in the future, although there is not specific date set. Version 2.0 is due out soon, but there
is no set time frame.

The memory requirements are not listed and after searching the various HoTMetal and
SoftQuad sites, I am unsure what they are.

2.2.2.2.6 Cost and Technical Support

The HoTMetaL sofiware is freeware, which means it can be used without cost for non-
commercial purposes. The software can be down-loaded to a client-based or server-based
environment.

Because it is freeware, there is no technical support for HoTMetaL through SoftQuad.
There information on the application at the SoftQuad home page.

2.2.2.3 HoTMetal Pro 2.0 (Windows)

2.2.2.3.1 Overview

HoTMetaL Pro 2.0 for Windows is an extremely easy to use HTML editor. In addition to
having most essential elements available from toolbar icons, the on-line help leads the
novice user through the processes to create anchors for links within the document, system
or over the web. Creating other elements such as forms and mail address accounts is also
very simple. The software also has extensive Macro building capacity.

2.2.2.3.2 Ease of Use

2.2.2.3.2.1 User Friendliness

HoTMetaL Pro 2.0 adheres to all GUI standards. It offers users easy ways to move
around the document including scroll bars, moving down or up a screen at a time, menu
bars, most options of which are duplicated on the tool bar. It also offers an autosave
function that can be set by the user. In addition to spell checking, you can edit the
dictionary and access a thesaurus.

The Help function is very robust and mirrors the hardcopy documentation. It takes the
novice user step-by-step through the process of the basic and advanced options of the
software. It does employ hypertext links and has a detailed step-by-step tutorial.
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2.2.2.3.2.2 Basic Editing Tools

The software offers undo and redo functions that are context specific depending on the
function that you have just completed. Cut and paste functions are also available within
the document and within other applications on the system.

The search/find function is able to search for text within elements. However, it doesn’t
offer the depth of searching ability seen in SGML editors, such as searching on elements
or attributes.

As mentioned above, one of the nicest functions of HoTMetaL Pro is the toolbar icons
that reflect almost all of the options available under the menus. When a file is open and the
cursor is moved across the icons, a help tag opens indicating the function of the icon. Not
all are intuitive, but there is an understandable order as to how they are grouped. Key
combinations are also available for most of the commands.

Foreign language characters, as well as those for math and science, are available two
ways: the special characters option under the Markup menu and the Styles option under
the View menu.

The HTML syntax checking offered by HoTMetaL Pro is intensive. It ensures the validity
of a document, but is also context sensitive. If the rules checking option is on when
building a document, the system keeps track with what element you are in. If you are
typing body text and hit return to start a new paragraph, the system puts in the paragraph
element for you. It also makes creating lists easy. When you click on the toolbar icon, it
inserts a list item code. If you hit return within the list item element, it gives you the code
for a new list item. This was not found on the other applications evaluated.

Documents from word processing applications can be imported into HoTMetaL Pro
easily. There are numerous basic applications, such as WordPerfect, the MS Word suite of
applications, ASCII and RTF. In addition, when installing the software, there is a list of
other applications that can be included on the list. Documents that were converted into
HTML included various headers and tables, all of which were marked correctly.

2.2.2.3.2.3 Document Display

HoTMetal. Pro works like most word processors in terms of how the user views the
elements. The user can view the document with the tags or without them. Begin and end
tags are differentiated by a forward slash (/). The tags and images can also be hidden or
shown in full.

2.2.2.3.2.4 Styles

HoTMetaL Pro offers you the ability to apply styles to specific text or characters.
However, some of the styles applied in the HTML editor may be overruled by the browser
in which it is viewed.

Styles can be saved in a generic hmpro2.stl binary file that is updated with whatever styles
are in effect for a file. Text-based style files can also be created and saved by selecting the
Save Styles option under the View menu. In this way, the user can save the specific style

2-36




used for the document being displayed. All style files are saved in the style directory.
Multiple style files can be applied to one document.

HoTMetaL Pro allows the user to set font size and type, foreground and background
colors, indention, spacing and paragraph styles.

2.2.2.3.3 Tables and Graphics

2.2.2.3.3.1 Tables

HoTMetaL Pro does support tables, but it warns that the definition of HTML tables is in
flux. Tables are “inserted” into the HTML document, but this lexicon refers to indicating
how many rows and columns should be represented. Once a table exists, it is fairly easy to
move around within it. Tables created in other software applications cannot be cut and
pasted into the document.

2.2.2.3.3.2 Graphics

GIF graphics can be viewed in HoTMetaL Pro. Other formats use a Internet browser that
accesses the external application to display the graphic. Importing graphics is very easy,
especially if they are GIF graphics. The user has only to click on the image icon and enter
the pathname of the graphic. For non-GIF graphics, the pathname of the external
application must also be indicated.

In HoTMetaL Pro, you can also create image maps that allow the user to connect a
certain portion of an image to another file. The documentation has very detailed
instructions on how to designate each portion of the image to specific files.

2.2.2.3.4 HTML Attribute Features Supported

AllHTML 2.0 elements are supported by HoTMetaL Pro. In addition, some elements of
HTML 3.0, including tables, and elements of Netscape are also supported.

Elements that you can create in HoTMetaL Pro include ordered, unordered and definition
lists, check boxes, radio buttons, action buttons and text boxes. You can also establish
mailto capabilities using the software.

To create any of the elements listed above, as well as more commonly used elements such
as paragraphs and headers, you have only to click on the proper icon in the toolbar. The
HTML editing component is also context sensitive and will not let you insert an invalid
element if the rules checking component is on. In addition to ensuring validity, the
software is sensitive to where you are in the document. If you are in the middle of an
ordered list-list item and you hit return, a new list item tag will appear. Attributes can also
be defined using the software.

The software allows anchors to be created simply by clicking on a toolbar icon. There are
also two other icons to indicate the source and target paths. The help is also very useful
for beginning users.
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2.2.2.3.5 Platforms

HoTMetaL Pro 2.0 was released in October for Windows-based systems. SoftQuad stated
the software will be updated for Windows 95, but did not give a specific date. The UNIX
version is currently at 1.0. The updated 2.0 version is due out in November 1995.

SoftQuad recommends that HoTMetaL Pro be run on at least a 486 system with 8 MG
RAM for Windows and Macintosh. The UNIX version that are available are SUN OS 4.1,
Solaris 2.2, HP UX 9000, IBM RS6000, IRIX 5.2 and SGI INDI.

2.2.2.3.5.1 Cost and Technical Support

The following price list indicates the cost per license. Each license comes with 30 days
free technical support.

Licensing Cost for HoTMetaL Pro 2.0

1-4 $195.00

5-9 $175
10 - 49 $160
50 -100 $155

100+ $148.95

LAN-based license are also available. You will receive a CD with product and electronic
manuals. This license also includes minor upgrades and debugging issues and 30 days of
free technical support. LAN licenses are available for UNIX, Windows and Macintosh.

LAN Licensing Cost Information for HoTMetaL Pro 2.0

25-100 $90.00

101 - 500 $84.00
500 - 1000 $70
1000 - 5000 $62
5000 - 10,000 $55
10,000+ $45

Technical support is available for both client-based and LAN licenses for 15% of the retail
price. No matter the amount paid for the individual license, the annual technical support
cost will be $29.95 per license.
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2.2.2.4 InContext Spider Version 1.01

2.2.2.4.1 Overview

InContext’s Spider is integrated with Spyglass Mosaic (and in version 1.1 with Netscape)
to browse the Internet, download pages and review work done on the Spider HTML
editor. Although documents can be created in HTML 2.0 and HTML 3.0 draft standards,
many elements are not automated. To create tables, the user must know the elements that
make up a table and create it using the element picklist. Forms and lists are also not as
automated as with other editors reviewed. There are toolbar icons, but no text description
of each icon making it a confusing process.

One highlight of Spider is it’s connectivity with the web. This makes the creation of
anchors to web sites very painless.

2.2.2.4.2 Ease of Use

2.2.2.4.2.1 User Friendliness

Spider uses basic GUI standards with scrolling capability, screen up and down capabilities,
menu bars, pop-up error messages and bookmark capability.

Spider does not offer a spelling function or thesaurus. The on-line help for the system is
not robust enough for any but advanced users. It includes hypertext search functions,
context sensitive help and basic information on HTML.

2.2.2.4.2.2 Basic Editing Tools

To ease the creation of HTML documents, the system has menus as well as toolbars for
basic editing and HTML functions including ordered and unordered lists, headers,
paragraphs, etc. Help text descriptions for the icons are not available when the cursor is
placed over the icons, which is a problem. Key combinations are available for some of the
basic functions.

As with most Windows-based software packages, Spider has cut and paste functions that
can operate with text inside and outside the application. There is also an undo function
and an extensive search capability that searches on elements and attributes as well as on
text.

Only foreign language characters are available on the system. Mathematical, scientific and
dingbat characters are not available on the software.

Spider has a very active HTML syntax checker. The application will not allow you to
place an element in an invalid location. Only HTML documents can be opened in Spider.

2.2.2.4.2.3 Document Display

Spider’s display is divided into two areas, the Logical and Content editors. The Logical
Editor lists the elements that comprise the document, while the Content Editor contains
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the text, images, and lists of the document. Both areas can be resized, although the
Content Editor needs more space because it contains the text, images and tables.

Because of the software’s setup, HTML elements are not usually represented as tags as
with most other HTML editors. Instead, the elements are listed in the Logical Editor.
Anchors, however, can be seen within the Context Editor.

Without the location of tags in the Content Editor, the user can view the document
without code, except for anchors, with basic styles applied.

2.2.2.4.2.4 Styles

Spider does not use style per say. Instead, the software comes with about 80 HTML
templates that can be used to create documents. They also have a specific HTML 3.0
DTD that supports draft HTML 3.0 elements and one to support Netscape tags.

Text can be bolded or italicized, but there is not a plethora of styles that can be applied to
text.

2.2.2.4.3 Tables and Graphics

2.2.2.4.3.1 Tables

Tables are supported in Spider version 1.01, but they have to build element by element.
The system will not allow you to insert an invalid element, but there is no automated
process for building tables. You cannot import a table into Spider.

2.2.2.4.3.2 Graphics

Graphics in Spider can be viewed in the software. All images, however, must be saved in
GIF format. Images from other web sites can also be accessed by including the proper
URL for it.

Graphics are imported easily, by selecting the image element and using the right mouse
button to pull up the Attributes Window. With the browse button, you can easily indicate
the directory path and filename.

Spider does offer the ability to create image maps that will anchor different parts of the
image to various locations.

2.2.2.4.4 HTML Attribute Features Supported

The software supports HTML Version 2.0 elements and draft HTML 3.0 elements as well
as Netscape tags. However, the process of creating some of these elements is not
automated. Attributes can also be defined for elements in the system.

There is an active SGML editing component built into the software. It will not allow the
user to insert an element in a non-valid location. The rules checker is context sensitive, but
the user has to be fully aware of what they are creating. Unlike other HTML editors
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reviewed, the software will not keep up with what the user is doing. If you hit Enter key
within a paragraph code, it will not include a new paragraph code.

Spider allows you to create elements such as ordered, unordered and definition lists. The
difficulty is that unlike other some editors, the system is not context sensitive. If you are
between list item tags, and hit the Enter key, the system will not insert another list item.
You must go back to the Edit menu and select the Element option to get a list of valid
elements. You can also place the cursor underneath the first list item element and hit
CTRL-L to get another list item. (This was discovered after talking to the Technical
Support line of InContext.)

Forms can also be created in Spider. Using the main forms icon on the toolbar gives
access to the other elements including check boxes, radio buttons, action buttons, list
choices and text boxes. The software does not have a mailto function in the editor.
However, Spider Technical Support stated that an anchor can be created and that used as

your URL.

One of Spiders highlights is its ability to create anchors across the web. Because of its
integration with browsers, the system is designed to facilitate these type of links without
problem.

2.2.2.4.5 Platforms

Spider version 1.1 was released during the writing of this report at the beginning of
November. Some elements (such as table support) have been integrated into this
evaluation.

The software runs on IBM PC or compatible 386 systems or above running MS Windows
3.1 (Windows 95). InContext Corp. recommends 8 MB of RAM, although it can be used
with 4 MB. Seven MB of free hard disk space is also required.

2.2.2.4.6 Cost and Technical Support

The cost for a single copy of Spider HTML Editor is $99.00. This does not include
shipping, but does include free technical support, via e-mail and telephone, for ninety days.
InContext also offers GSA pricing. For each license, the price is $74.25, which includes
shipping and the ninety days of technical support.

There is currently neither long-term technical support nor are LAN licenses available.
2.3 SGML Viewer

2.3.1 SGML Viewer Evaluation Criteria

The criteria given here were developed as a guideline for the evaluators when reviewing
the software products under each section. These criteria were intended to help the
evaluator focus on issues of usability, suitability to task, and cost.
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2.3.1.1 Overview

In a brief paragraph describe, in general, the positive and negative points of the software.
Give a brief description of the overall set-up of the software. Is the set-up intuitive or
confusing?

2.3.1.2 Ease of Use

Does the software follow basic GUI standards?

Does the software provide multi-window viewing capabilities?

Does the software keep track of what files you have viewed?

Are bookmarks available and easy to use on the software?

Does the software provide a search and replace function?

Does the software have a search function that can search on elements as well as text?
Can the software display a table of contents that helps navigation through the document?
Does the software provide on-line Help Search function?

Does the software provide any type of CBT or step-by-step demonstration of how to
accomplish certain functions?

Is the Help function robust enough to allow a beginning end-user to use the software
easily?

2.3.1.3 Tables and Graphics

What graphic formats does the software accept?

Can the graphic be cropped or just resized by the software?

How are graphics displayed in the software?

How are video and audio files processed by the software?

Are all tables in SGML format (J20008, CALS or ATA) supported by the software?

Can tables be edited in the viewer?

2.3.1.4 SGML Importation

Does the software easily import SGML documents from multiple systems as long as the
DTD exists?

Can the software easily import DTDs without problem?
Does the software support HTML DTDs used with the SGML document instances?

2.3.1.5 Style and Attributes

Can multiple styles be applied to the document when viewing it?
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Can style sheets be loaded into the software without problem?
Does the software allow the style sheet to be modified?

Can the software easily adapt FOSI or DSSSL styles?

Can attributes be edited, modified or added in the software?
Can paragraph security attributes be used?

Does the viewer support HYTIME?

Does the viewer allow hyperlink sources to contain destinations distributed over a LAN,
WAN or Internet?

2.3.1.6 Platforms
Which platforms (operating systems or hardware) can this software be used on?
Are there any plans to port the software to other platforms in the near/foreseeable future?

What are the memory needs of the software?

2.3.1.7 Cost and Technical Support
Are LAN licenses available?
Are there pricing discounts for quantity purchases?

What type of technical support is available and what is the cost?

2.3.2 SGML Viewer Product Evaluations

Below is listed a rating of the SGML Viewers that were evaluated for this project. These
ratings were derived from the actual evaluations of the products, and are given as a guide
to the relative capabilities of the products. These ratings should be used in conjunction
with the actual product evaluations, given later in the report.

Summary of Evaluation of SGML Viewers

Overview 43
Ease of Use A Ak
Tables & Graphics Yo Yook
SGML Importation i g Qg oA e
Style & Attributes v Yo
Platforms A g Qe
Cost & Support Yk
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2.3.2.1 Panorama Pro v1.0 - SGML Viewer

2.3.2.1.1 Overview

Panorama Pro, made by SoftQuad Inc., is currently the only commercial SGML Viewer. It
is an easy to use application that allows you to view and manipulate SGML documents. It
interfaces with NCSA Mosaic, Spyglass Mosaic, Netscape 1.22 or Netscape 2.0, all of
which are evaluated later in this document. It can view SGML documents pulled from the
Internet using the browsers or in-house documents.

2.3.2.1.2 Ease of Use

Panorama Pro is a GUI-based application that is easy to use and reflects the basic
functions of most Windows-based applications. The software offers numerous
navigational aids including back and forward arrows and bookmarks. This allows you to
view multiple documents by toggling between them. A separate window can be opened to
view graphics, but not documents. The Back and Forth arrows allow you to revisit all
sites/files opened while using the system. Because of the integration with Internet
browsers, this includes world wide web (WWW) sites.

In Panorama Pro, bookmarks are used to flag important sections, or words in text. The
process of marking an area is easy. After highlighting the text, open the Webs menu and
select the Bookmark option. When the Annotation Window opens, ensure the Bookmark
box is checked and enter the desired name for the bookmark. This is automatically entered
into the list. To go to a bookmark, simply select it from the Bookmark menu. If the
document is not open, the system will open it and display the area of the bookmark.
Panorama Pro also allows you to make annotations such as footnotes or personal critiques
of a document.

The Search function allows words, elements and attributes to be searched within the
document. Words can be searched within the document, or within an entity of the
document. Panorama Pro uses what it calls Occurrence Density Display to indicate by
horizontal lines on the scroll bar the number of matches in the document. The more
horizontal lines in one area, the greater the number of matches. It is a bit confusing at first,
but makes finding elements or words in the document much easier. To scroll to the desired
area, just click on a mark.

The Navigator function in Panorama Pro works interactively with the document being
viewed. Users can organize the table of contents for the document based on the SGML
elemental structure of the document, a list of all graphics or tables, or simply elements in
the SGML document. Once an element is selected in the table of contents, that portion of
the document is displayed. This process is quick, trouble-free and helpful for publishing
organizational elements of the document.

The on-line help includes an on-line manual and example documents that can be used to
acclimate oneself to the system. It seems adequate to do the job. Terminology is different
than other applications and the use of Webs and Navigation menus are misleading as the
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system works so closely with WWW browsers, but doesn’t perform any Internet
functions.

The Web option in Panorama Pro allows you to link documents across the Internet, with
the help of the Internet browser, or create links among documents on your system, similar
to HTML software. (The Internet browser is used to handle URLs.)

2.3.2.1.3 Tables and Graphics

Panorama Pro Version 1.0 supports GIF, BMP and WMF graphic formats. The Help
menu has specific information on how to include notations for the graphics.

There are two ways a graphic can be viewed using Panorama Pro. The application can be
configured to hand-off any graphic element to a specific graphics application such as Paint
Shop Pro. The WWW browser connected to Panorama Pro can also be used to view
graphics, as well as audio or video files.

Panorama Pro supports tables as long as there is a valid DTD, and the tables are in SGML
formats such as CALS, ATA or J2008. You cannot edit the table as you would in SGML
editing software.

2.3.2.1.4 SGML Importation

Panorama Pro supports SGML document instances from other applications without a
problem as long as the DTD either exists in the system or is copied into the correct
directory. Copying DTDs is an easy procedure that can be done in Windows File Manager
or DOS prompt.

Panorama Pro supports the recently ratified HTML 2.0 standards and those for HTML
3.0, as long as the document is based on a valid DTD. 1t also supports HTML as a link
from an SGML document to HTML document. The HTML portion would be loaded and
viewed in the WWW browser and not Panorama Pro. The software will also allow you to
create SGML documents with imbedded objects. If the links are not to objects in the
system, the browser will step in to complete the URL links.

2.3.2.1.4.1 Styles and Attributes

The system allows multiple style sheets to be applied to one document. Panorama Pro has
a series of style sheets that can be applied to any SGML document, but you can also load
standard (_ssh) style sheets into the system. If the SGML editing software from which the
style sheet comes turns style sheets into a proprietary format, it could prove difficult to
apply without examining and possibly changing the ASCII version of the style sheet. This
is an advanced user capability.

The software does allow you to edit style sheets. With an SGML file open, attach a style
sheet. To show tags for the style sheet, click on an element in the document with the right
mouse button. A style palette will open. In the palette, you can change the element’s style.

Panorama Pro saves style sheets in an SGML structure loosely based on DSSSL formats.
The files all include the document type declaration at the top of the file.
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If the paragraph security level is already indicated in the SGML document as an attribute
to an element, then Panorama Pro will support it. However, attributes cannot be changed
within Panorama Pro. ’

Panorama Pro supports HYTIME if the links are within a document. If the links cross to
another site, then the WWW browser must be used to access the other link.

Because of Panorama Pro’s connectivity with a browser, you can view hyperlink sources
over a LAN, WAN or the Internet. The split between the software allows each to do what
it does best. The Internet Browser is used to contact other servers and locations, while
Panorama concentrates on manipulating SGML files. Panorama Pro does support SGML
tables, both complex and simple.

2.3.2.1.5 Platforms

Panorama Pro Version 1.0 works with either Mosaic (NCSA or Spyglass), Netscape 1.22
or Netscape 2.0 as the WWW browser. It currently runs only on a Windows Environment,
version 3.1 or later. UNIX (Sun/HP) will be out within the next two months with a
Macintosh version available in the December-January time frame.

SoftQuad Inc. recommends a 486 system with 8 MB RAM and 4 MB of disk space.

Both server- and client-based licenses are available for Panorama Pro Version 1.0. The
server-based license is available for more than 25 concurrent users. With the client-based
license, you receive the manual and 40-day tech support. The server-based license come
with electronic documentation that can be downloaded and printed. Hardcopy manuals
can be purchased for $15-20 each.

2.3.2.1.6 Cost and Technical Support

Panorama Pro does not offer GSA pricing, but there are discounts for large purchases and
additional discounts may be negotiated with the company.

Cost Information for Panorama Pro

Client/ 1-4 $195.00 $100.00 or $25 per call*
Client/5-9 $175.00 $100.00 or $25 per call*
Client/10-50 $160.00 $100.00 or $25 per call*
Client/50-100 $155.00 $100.00 or $25 per call*
Server/1-50 $90.00 Under Review
Server/51-100 $ 84.00 Under Review
Server/100+ $ 84.00 Under Review

* Client-based includes 30-days free support
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2.4 HTML Browsers

2.4.1 HTML Browser Evaluation Criteria

The criteria given here were developed as a guideline for the evaluators when reviewing

the software products under each section. These criteria were intended to help the

evaluator focus on issues of usability, suitability to task, and cost.

2.4.1.1 Overview

In a brief paragraph describe, in general, the positive and negative points of the software.

Give a brief description of the overall set-up of the software. Is the set-up intuitive or

confusing?
2.4.1.2 Ease of Use

2.4.1.2.1 User Friendliness

Does the browser offer a user-friendly Graphical User Interface (GUI)?
Does the browser toolbar have buttons for frequently used commands?

Is access to Internet Newsgroups simple and easy?

Does the browser have robust on-line help?

Does the browser provide point-and-click elements to navigate the Internet?
Does the browser keep track of the locations visited on the Internet?

Can multiple windows be opened?

Are bookmarks available and easy to use?

2.4.1.2.2 Basic Tools

Is there an Internet search engineer integrated into the browser?
What type of other tools does the navigator have.

Does it support HTML 3.0 tables?

2.4.1.2.3 Document Layout and Presentation

Does the browser support HTML 2.0 standards?

Does it load text and graphics simultaneously?

Does the browser support tables based on HTML 3.0 standards?
Does the browser support all World Wide Web standards?

What image formats are supported by the browser?
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Which foreign languages are supported by the browser?
2.4.1.3 Technical Features

2.4.1.3.1 General Performance and Operability
What is the performance at low-bandwidth (14.4k bps)?
Does the browser have native JPEG decompression?
Does the browser have native sound support?

What type of caching is performed?

Does the browser operate with common network servers such as: HTTP, Gopher, FTP,

NNTP, SMTP, POP3?

Can the browser dynamically execute programs anchored in the product being viewed

over the Internet? (This is also known as Hot Java support.)

Does the browser provide an efficient FTP capability that would provide feedback on the

status of a download?

Does it support Windows 95?

2.4.1.3.2 Electronic Mail

Can the browser to send e-mail via a “mailto” hyperlink within an HTML document?
Can the browser deal with MIME attachments?

Is the configuration of the mail system straight-forward?

2.4.1.3.3 Security
Does the browser have secure transfer of on-line forms data?
What type of security is available at the news/conferencing for NNTP?

Does the browser indicate whether a secure document is being entered?

2.4.1.3.4 Usenet News
Does the browser have an interface for accessing Internet News?
If yes, can it handle MIME messages for multimedia?

Describe briefly the configuration process.

2.4.1.4 Extensibility

Does the browser support external software applications and viewers for enhancing
multimedia activities over the Internet?

Can they be built into it?
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2.4.1.5 Set-up and Installation

What are the requirements for setting up and installing the software?

2.4.1.6 Platforms
On which platforms does the software run?
What are the memory requirements of the software?

Are there any plans for upgrades?

2.4.1.7 Cost and Technical Support
What is the cost for licenses?

Are LAN licenses available, or only client-based?
What type of technical support is available?
What is the cost for the Technical Support?

2.4.2 HTML Browsers Product Evaluations

Below is a rating of HTML Browsers evaluated during this project. The ratings were
derived from evaluations of the products, and should be used only as a guide to the
products’ relative capabilities in conjunction with the evaluations. Each browser was
evaluated based on use on Intelink versus on the Internet. The difference is that the

Intelink score does not include Electronic Mail, Security and Usenet News capabilities.
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2.4.2.1 NCSA Mosaic Browser Evaluation

2.4.2.1.1 Overview

NCSA Mosaic operates on three different platforms. Mosaic v 2.0 for Windows offers the
most functions. The UNIX version is 2.7b1 and the Macintosh version is 2.0.1. The
browser is available from the Internet without cost for non-commercial use. The difference
between options on the various platforms were taken into account and caused lower

overall ratings in some instances.
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Although NCSA Mosaic is free for non-commercial use, it is important to note that it does
not offer secure data transfer capability and has very limited e-mail functions. In addition,
it does not offer the range of multimedia capabilities as other browsers. It does, however,
offer a user-friendly environment to access the Internet with point-and-click commands
and elements that lets the user navigate easily through the Internet. In the Windows
version, users can enter Web addresses without the HTTP protocol prefix — Mosaic
generates it automatically. A pop-up menu lets users view and track their navigation
history through a separate window, and users can move forward and backward through
the history. Only the UNIX browser (v2.7b1) has the option of opening multiple windows
for browsing. The NCSA Mosaic (for Windows v2.0.0) offers an advanced bookmark
facility called the Hotlist Manager. It is simple to use and lets users maintain, index, track,
organize and search a hierarchical list of favorite web sites.

2.4.2.1.2 Ease of Use

2.4.2.1.2.1 User Friendliness

Of the NCSA Mosaic browsers, only the Windows version has a user-friendly and user-
configurable Graphical User Interface (GUI) that includes a toolbar and directory buttons.
The toolbar is used for frequently used commands. All versions contain both slow and fast
scrolling capabilities, but do not have button-access to an Internet search engine.

The Windows version also supports Windows help. The mosaic.hlp file is installed in the
Mosaic directory during Mosaic’s installation. You can open Mosaic help from the Help
menu, the question mark on the toolbar or by selecting F1 from the keyboard. For all other
versions help is available from the Help menu. Mosaic help is context sensitive and you
may point-and-click on the area where you need help.

2.4.2.1.2.2 Basic Tools

The basic tools for NCSA Mosaic differ depending on which platform/version is being
used. Below the platforms are divided. All versions have print, print preview and print
setup capabilities. English is the only language supported by the browser.

The Windows version supports HTML 3.0 tables as well as referrer field support, which is
used by HTTP administrators for statistical purposes to determine the origin of their
network traffic. The user can also transfer a file from their system to a remote machine
using the new right mouse menu feature. This features is active only when a user is logged
onto an FTP server. The Windows version also offers Hot Key Mappings (character
combinations) to open the Preference menu, add to a hotlist, go to the end of the page,
find, find again and stop transfer.

2.4.2.1.2.3 Document Layout and Presentation

NCSA Mosaic for Windows provides full support for HTML 2.0 and some support for
HTML 3.0 including HTML 3.0 body tag attributes (changes color of background and
text). For all platforms it supports the Mailto attribute, which sends an e-mail by pointing
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and clicking on a hyperlink within an HTML document. NCSA Mosaic for Windows also
has the option of changing the color of the background of the text, unvisited links and
visited links within the browser The links, however, are not clearly marked.

2.4.2.1.3 Technical Features \

2.4.2.1.3.1 General Performance and Operability

NCSA Mosaic offers good performance in high-bandwidth environments, but poor speed
performance for low-bandwidth (14.4k bps) environments.

The browser can instantaneously display text and uses progressive display for images. It
has local disk caching capability, native GIF and JPEG image support and works in any
environment that supports HT TP-compliant network clients, including Winsock. It also
offers full support of all World Wide Web standards and works with most common
network servers such as: HTTP, Gopher, FTP, NNTP.

However, the browser does not offer native support for video, but external applications
can be used. Also, only the Windows version of the software supports native . WAV sound
support.

2.4.2.1.3.2 Electronic Mail

Only NCSA Mosaic v2.0.0 for Windows provides integrated e-mail capability that is
simple to use but limited in function. E-mail may only be sent, but cannot be received. The
software does support MIME attachments. In the UNIX and Macintosh versions, there is
no integrated e-mail support. Users can only send HTML documents/pages viewed over
the Internet.

The e-mail interface (for Windows) is accessed by selecting the Send Mail option in the
File menu or by pointing and clicking the e-mail button on the toolbar. Configuration of
mail is simple because Mail and News share a common folder called Services which is
found under the Preference option where user information and SMTP server information
is supplied.

2.4.2.1.3.3 Security

Currently, NCSA Mosaic is not capable of secure data transfer. However, the user can
route HTTP-based packets through proxy servers which are behind a firewall. This is not a
basic user capability, however. In addition, no warning message is given to the user while
entering data, such as credit card information, in an unsecured on-line form.

2.4.2.1.3.4 Usenet News

With the NCSA browser, Internet Newsgroups can be easily accessed from the main
window. The NCSA Mosaic is not a full-fledged news reader, but it is possible to thread
articles, post articles, reply to articles. The version 2.0 for Windows has a news toolbar
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interface that can be moved to any border on the window or it can besa floating window.
Configuration of News requires only the name of the NNTP server.

2.4.2.1.4 Extensibility

NCSA Mosaic supports a range of external viewers and MIME types for enhancing
Internet and multimedia activities. Below are a few examples of tools/applications that
can be seamlessly built into NCSA Mosaic:

e SoftQuad Panorama SGML Viewer (Windows only)
e Adobe Acrobat Reader

e MPEG Video Players

¢ QuickTime Video Players

e Postscript Viewers

e JPEG and TIFF Image Viewers

e WHAM Audio Player

¢ Microsoft Word Viewer v6.0 (Windows only)

2.4.2.1.5 Set-up and Installation

The set-up procedure for the NCSA Mosaic is easy. Compiled binaries are available for
UNIX platforms. The Windows version is a 32-bit application and Microsoft’s Win32s
with OLE software must be loaded before installing Mosaic. Mosaic’s installation program
(for Windows), setup.exe, is also a 32-bit application. Windows NT and Windows 95
users should not install Win32s with OLE.

2.4.2.1.6 Platform Requirements

Platform Requirement Information for NCSA Mosaic

s

RN

S
AN

BRSO

Windows 2MB "~ 4MB 8MB

Macintosh System 7 or 3MB 6MB 8MB
later
UNIX N/A 7™MB 16MB 16MB
Intel (x86) based:

e  Windows 3.1
e Windows for Workgroups 3.11
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¢ Windows 95
e Windows NT version 3.5

Apple Macintosh:

e Macintosh System 7 or later
e Power Macintosh
UNIX:
e Digital Equipment Corp. Alpha (OSF/1)
e Digital Equipment Corp. MIPS (Ultrix)
e Hewlett-Packard 9000/700 series (HP-UX 9.x)
e IBM RS/6000 AIX 3.2
e Silicon Graphics (IRIX 4.x, Indy)
e Sun SPARC (Solaris 2.3, SunOS 4.1.x)

e Linux for x86

2.4.2.1.7 Cost and Technical Support

There is no licensing requirement for NCSA Mosaic if it is used in a non-commercial
environment. If, however, it is used commercially, users need to contact Spyglass, Inc. for
information about a commercial license.

NCSA Mosaic may be obtained by anonymous users from NCSA Mosaic’s FTP site for
no charge, or users can receive it on a diskette for a small fee. No maintenance support is
available, but users may receive technical support by contacting them through the e-mail
address — mosaic@ncsa.uiuc.edu.

2.4.2.2 Spyglass Enhanced Mosaic Browser Evaluation

2.4.2.2.1 Overview

The Spyglass Mosaic v2.0 for Windows is the commercial version of NCSA Mosaic.
Although it offers users an easy environment to access the Internet, it lacks advanced
features common to other commercial browsers or even NCSA Mosaic for Windows. It
has no e-mail function, but does offer Spyglass Mosaic Security Framework, an open,
modular architecture to support various security protocols. One of the nice features is a
pop-up menu that opens a separate window to allow users to move easily back and forth
in the search history. Spyglass Mosaic also offers a bookmark facility which is simple to
use and lets users maintain and track hierarchical list of favorite web sites.

During the writing of this report, Spyglass Mosaic 2.1 was released. This new version is
said to provide new capabilities such as full HTML 3.0 tables support, HTML features
support for colored text and alignment of text and images. It also reportedly performs
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secure transmissions for credit card purchases, and reduces language barriers by offering a
language negotiation and localization function that can display a document in the preferred
language of the user. In addition, it will automatically generate the HTTP protocol prefix
automatically, send e-mail to addresses linked directly from Web pages, and access
Internet sites from a customized hotlist. The evaluation ratings are based on Mosaic v2.0,
not v2.1.

2.4.2.2.2 Ease of Use

2.4.2.2.2.1 User Friendliness

Spyglass Mosaic has an intuitive graphical user interface (GUI) that allows users to travel
the World Wide Web (WWW) with ease. Some of the features include a toolbar that holds
frequently-used commands, access to popular sites directly from the customizable hotlist,
and the ability to return to sites directly from the history list.

Spyglass Mosaic supports Windows help. Users can open Mosaic help from the Help
menu, from the question mark on the toolbar, or they may select F1 from the keyboard.

2.4.2.2.2.2 Basic Tools

Users have to option to set up their printer and preview their print jobs. English is the only
language supported.

2.4.2.2.2.3 Document Layout and Presentation

The Spyglass Mosaic provides full support for HTML 2.0, but not for HTML 3.0.
Spyglass Mosaic does, however, have the ability to change the color of the document’s
background, unvisited links and visited links within the browser. The hyperlinks are
underlined which makes it simple for the user to navigate.

2.4.2.2.3 Technical Features

2.4.2.2.3.1 General Performance and Operability

Spyglass Mosaic has a performance-enhancing feature that increases the speed and
efficiency of Internet navigation, even for low-bandwidths of 14.4k bps. Spyglass uses
Smart Maps, a Spyglass innovation, to configure image maps. Smart Maps reduces the
need for server intervention, allowing users to link to new documents quickly. Smart Maps
works in CD-ROM applications as well as across the Internet. The instantaneous display
of text and the progressive display of images enable users to access hyperlinks before a
document finishes downloading.

Spyglass offers local disk caching, native AU and AIFF sound support, native GIF and
JPEG image support and full support of all WWW standards and inter-operability with
most common network servers such as: HTTP, Gopher, FTP, NNTP, SMTP. The
software also works in any environment that supports HTTP-compliant network clients,
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including Winsock. There is no native support for video, but external applications can be
used.

2.4.2.2.3.2 Electronic Mail (E-MAIL)

Spyglass Mosaic has no built-in provisions for sending or receiving e-mail. It does,
however, support SMTP so that external mail applications may be built within the
application.

2.4.2.2.3.3 Security

Spyglass Mosaic Security Framework provides an open, modular architecture to support
arbitrary security protocols in a uniform fashion. To meet user name/password security
needs, Spyglass Mosaic offers two pre-installed modules: Basic Authentication and Digest
Authentication. For more complex security needs, users can plug in their security scheme
of choice through the Spyglass Mosaic Security Framework. With this open framework,
Spyglass Mosaic enables various forms of security on the WWW, without dictating a
specific security policy. Policy decisions are under the control of the content provider and
the content provider is free to choose the appropriate technology necessary for a given
class of documents.

Spyglass Mosaic also has the ability to route HTTP packets through proxy servers that are
behind a firewall.

2.4.2.2.3.4 Advanced Features

Spyglass Mosaic is not a full-fledged news reader, nor is it user-friendly. Although an
external news program can be built into it, and Mosaic can be configured to access
newsgroups, it isn’t a point-and-click function. To configure Spyglass Mosaic to access
Newsgroups, chose Preferences from the Edit menu and enter the name of the news server
(NNTP) in the News Server field. To list the available Newsgroups, users need to type
news:* in the URL field.

2.4.2.2.4 Extensibility

Spyglass Enhanced Mosaic supports a range of external viewers and MIME types for
enhancing Internet and multimedia activities. Below are a few examples of
tools/applications that can be seamlessly built into Enhanced Mosaic:

e SoftQuad Panorama SGML Viewer (Windows only)
e Adobe Acrobat Reader

e MPEG Video Players

¢ QuickTime Video Players

o Postscript Viewers

e TIFF Image Viewers
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e WHAM Audio Player
e Microsoft Word Viewer v6.0

2.4.2.2.5 Set-up and Installation Procedure

The set-up procedure for Spyglass Mosaic is quite simple. Since Spyglass Mosaic is a 32-
bit application, users must install Microsoft’s Win32s with OLE software before installing
Mosaic. Installation program setup.exe is also a 32-bit application. Windows NT and
Windows 95 users should not install Win32s with OLE.

2.4.2.2.6 Configuration Requirements

Configuration Requirement Information for Spyglass Mosaic

AR

N S 5 25 N
~<$t§$§§:§§\§‘\§$. SR \\%ﬁ;\:ﬁg‘&}%
. . s .
Windows 386x 386SX 2MB 4MB 8MB
Intel (x86) based:

e Windows 3.1
e Windows for Workgroups 3.11
e Windows 95

e Windows NT version 3.5

2.4.2.2.7 Cost and Technical Support

Spyglass only licenses Mosaic (client-based) on an Original Equipment Manufacturers
(OEM) basis in large volumes of 10,000 or more licenses.

License Costs for Spyglass Mosaic

10,000 $8.00 $80,000.00
25,000 $5.00 $125,000.00
50,000 $3.33 $166,500.00

Maintenance support may be purchased on an annual basis for $25,000. Support includes
updates, new versions, and backup technical support.
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2.4.2.3 Netscape v 1.22 Browser Evaluation

2.4.2,.3.1 Overview

Netscape Navigator v1.22 for Windows/Windows 95/NT and v1.12 for UNIX and
Macintosh is a shareware, available for $39.00. It offers a user-friendly environment to
access the Internet. It provides simple point-and-click commands and a number of
advanced interface elements that make navigating the Internet easier and more pleasant.
The Navigator has pop-up menus that provide context-sensitive access to advanced
features and tracks historical navigation. A right mouse button pop-up menu allows access
to a variety of common documents, link and image commands. Users can also enter
WWW addresses without the HTTP protocol prefix, and they can go forward and
backward into their history with ease.

2.4.2.3.2 Ease of Use

2.4.2.3.2.1 User Friendliness

Netscape Navigator is very user-friendly and offers user-configurable Graphical User
Interface (GUI) including a toolbar and directory buttons. The toolbar contains frequently
used document and Internet navigation commands. One important feature is the one
button access to powerful Internet search engines. Moreover, easy access to Internet
Newsgroups is available via a button integrated into the browser’s toolbar. It also offers
slow and fast scrolling capabilities.

The Preference menu, under the Options menu, is easily accessed and opens a separate
window showing all the items as folders. There may be, for example, a separate folder for
News to specify your NNTP news server. Users can select the color folder within this
menu to change the colors for text, hyperlinks and document backgrounds displayed on
the browser.

Netscape Navigator also offers bookmarks that allow users to maintain, index, track,
organize and search a hierarchical list of favorite Web sites. The new enhanced bookmark
function available on the Windows version, provides a drag-and-drop, folder-based
interface for saving and accessing your favorite sites. Users can drag-and-drop links from
any Web page into the bookmark window and arrange them according to their needs.
Complete with search capabilities, the new bookmark feature allows anyone to create their
own roadmap to the Internet.

A pop-up menu also opens a separate window to view and track history and to create
bookmarks. Using the menu, multiple windows can be opened for browsing. The browser
also possesses search button to search within an Internet document

On-line help is available via the Help menu and provides help and information on
registration, upgrades, release notes, security, frequently asked questions, basic functions
and how to create Web services.
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2.4.2.3.2.2 Basic Tools

Netscape Navigator supports HTML 3.0 tables, Windows 95 features (32-bit version
only) and drag-and-drop Internet shortcuts to instantly access Web sites from your
desktop. Netscape’s File Transfer Protocol (FTP) interface provides users with greater
feedback on the status of an FTP download, the ability to route the file to a particular
destination, and the ability to perform multiple downloads (Windows only) simultaneously.

The software offers “dynamic” documents, where the server pushes new data down to
Netscape Navigator for continuously updated information such as stock quotes or weather
maps.

Printing and print preview capabilities are also available. The only language supported is
English.

2.4.2.3.2.3 Document Layout and Presentation

Netscape Navigator for all platforms provides full support for HTML 2.0 and quite a few
HTML 3.0 features such as background color and images, font size, tables, centering and
text blinking. It also supports the mailto attribute that allows users to send e-mail by
clicking a hyperlink within an HTML document. The user can also direct the browser to
use specific colors for a document’s background, text, unvisited links and visited links.
The hyperlinks are underlined which makes it simple for the user to navigate.

2.4.2.3.3 Technical Features

2.4.2.3.3.1 General Performance and Operability:

Netscape Navigator offers excellent performance even for low-bandwidth (14.4k bps)
environments. Some of the methods that enhance performance include multiple,
simultaneous loading of text and images, intelligent three-level persistent caching and
quick, seamless access to CD-ROM-based media. All platforms also support native JPEG
decompression, native JPEG and GIF images support for graphics, and support for
Japanese text in documents.

It also offers full support of all World Wide Web standards and inter-operability with most
common network servers such as: HTTP, Gopher, FTP, NNTP, SMTP. Netscape also
works in any environment that supports HTTP-compliant network clients, including
Winsock. The cross-platform development of the software that guarantees a common
interface and common behavior.

The software doesn’t contain native support for Video, but external applications can be
used. The Windows version supports native AU and AIFF sound support.

2.4.2.3.3.2 Electronic Mail (E-MAIL)

All platforms support integrated e-mail capability that is easy to use, but has limited
functions. Users can send e-mail messages but cannot receive them. The e-mail function
does allow you to send MIME attachments, both local files and documents, and view
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signatures. Some information needs to be provided the system within the Preference
option under the Options menu before the mail function will work. The mail interface
opens by selecting the Mail Document option with the File menu.

Netscape Navigator can also be integrated with Microsoft Exchange support, which
allows users to send and receive e-mail, create address lists, and include enclosures from
within Netscape Navigator using the Microsoft Exchange mail client.

2.4.2.3.3.3 Security

Netscape Navigator uses the open Secure Sockets Layer (SSL) protocol and RSA
encryption technology for secure communications and commerce on the Internet. This
multi-protocol security method is currently implemented to provide secure versions HTTP
to provide secure transfer of Web pages and on-line forms data. Netscape also provides
secure usenet news/conferencing capabilities via SSL support for NNTP. The SSL which
has been adopted by major Internet vendors and financial institutions provides server
authentication, encryption and message integrity. Server authentication verifies the identity
of the server through a certificate and a digital signature. Encryption ensures the privacy
of client/server communications by encrypting the data stream between the two entities.
Message integrity verifies that the message arrives at its destination in the same form as it
was sent.

The Netscape Navigator has the ability to route SSL-based connections (HTTP or NNTP)
through proxy servers which are behind a firewall. A warning message is given to user
while entering data (such as credit card information, password, etc.) in an unsecured on-
line form.

2.4.2.3.3.4 Usenet News

Internet Newsgroups are accessed by clicking on a button in the Netscape browser. The
news interface is quite enhanced and includes hierarchical newsgroup browsing, searching
and transparent MIME message handling for multimedia and hypermedia news posting.
Configuration of News simply requires indicating the name of the NNTP server in the
Preference option under the Options menu.

2.4.2.3.4 Extensibility

Netscape supports multiple applications and viewers for enhancing Internet and
multimedia activities. The following tools/applications can be seamlessly built into it:

e SoftQuad Panorama SGML Viewer (Windows only)
e Adobe Acrobat Viewers

e MPEG Video Players

¢ QuickTime Video Players

e AVI Video Player

e Windows Multimedia Player
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¢ Postscript Viewers
e WHAM Audio player
e TIFF Image Viewers

2.4.2.3.5 Set-up and Installation Procedure

The set-up procedure for Netscape Navigator is pretty simple. For Windows 3.1 and 3.11,
the 16-bit version is required. For Windows NT and 95 the 32-bit version is required.
Compiled binaries are available for UNIX platforms. To install the navigator on Windows
versions, double-click on the Setup file. The Setup procedure will ask the user for the
target directory for the installation.

2.4.2.3.6 Configuration Requirements

Configuration Requirement Information for Netscape Navigator

Windows 386SX 386SX

Macintosh 68020
UNIX N/A

Intel (x86) based:
e  Windows 3.1
e Windows for Workgroups 3.11
¢  Windows 95
e Windows NT
Apple Macintosh:
e Macintosh System 7
e MacOS
e PowerPC
UNIX:
¢ Digital Equipment Corp. Alpha (OSF/1 2.0)
e Hewilett-Packard 700-series (HP-UX 9.03)
e IBMRS/6000 AIX 3.2
e Silicon Graphics (IRIX 5.2)
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¢ Sun SPARC (Solaris 2.3, SunOS 4.1.3)
o 386/486/Pentium (BSDI)

2.4.2.3.7 Cost and Technical Support

Netscape only offers client-based licenses. No site or concurrent licenses are available.
Netscape Navigator 1.22/1.12 for Windows, Macintosh and UNIX-based systems is
$39.00 per license. The table below lists the discount prices.

Cost Information for Netscape Navigator

1-9 $39.00
10-249 $33
250-499 $27
500+ Will Quote Cost

Netscape offers two different types of maintenance support. The first is for subscription
upgrades to software for $17.00 per year per license. Support maintenance (phone and e-
mail) is available for $6.29 per license, with a minimum of $500 in support maintenance
purchased.

2.4.2.4 Netscape 2.0 browser Evaluation

2.4.2.4.1 Overview

Netscape Navigator v 2.0 B1 is by far the most advanced of all the browsers evaluated. It
offers all capabilities of the other browsers in addition to full e-mail functions, support for
English, French, German and Japanese, support for Live Objects and other interactive
multimedia content such as Java Applets, frames and Netscape inline plug-ins. It also has
extensive support capabilities for Windows 95.

2.4.2.4.2 Ease of Use

2.4.2.4.2.1 User Friendliness

Netscape Navigator has a very user-friendly and user-configurable Graphical User
Interface (GUI) including toolbar and directory buttons. It contains both slow and fast
scrolling capabilities. The toolbar contains frequently used document and Internet
navigation commands. It also has pop-up menus that provide context-sensitive access to
advanced features. One important feature is the one button access to the powerful Internet
search engines.
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Netscape Navigator also offers an improved bookmark facility which is very easy to use
and lets users maintain, index, track, organize and search a hierarchical list of favorite Web
sites. The bookmark feature provides a drag-and-drop, folder-based interface for saving
and accessing your favorite sites. Users can drag-and-drop links from any Web page into
the bookmark window and arrange them according to their needs. Complete with search
capabilities, the new bookmark feature allows anyone to create their own roadmap to the
Internet.

Users can go back and forth in the history with ease. A separate window can also be used
to view and track history, and create bookmarks. Using the pull-down menu multiple
windows can be opened for browsing. The browser also possesses search button to search
within an Internet document

On-line help is available via a pop-up menu and provides help and information on
registration, upgrades, release notes, security, frequently asked questions, basic functions
and how to get support and create Web services.

2.4.2.4.2.2 Basic Tools

Netscape Navigator supports HTML 3.0 tables as well as English, French, German and
Japanese text. Netscape’s File Transfer Protocol (FTP) interface provides users with
greater feedback on the status of an FTP download, the ability to route the file to a
particular destination, and the ability to perform multiple downloads simultaneously.

The software offers “dynamic” documents, where the server pushes new data down to
Netscape Navigator for continuously updated information such as stock quotes or weather
maps. Print and preview capabilities are also available.

It also supports Windows 95 features for the 32-bit version of Netscape including drag-
and-drop Internet Shortcuts to instantly access Web sites from your desktop. It also
supports Microsoft Exchange, which allows users to send and receive e-mail, create
address lists, and include enclosures from within Netscape Navigator using the Microsoft
Exchange mail client. Windows 95 dial-up networking is also available. It allows users to
connect Netscape Navigator to service providers. It also has the ability to embed Netscape
Navigator web pages into any OLE 2.0 container, including applications such as Microsoft
Excel, WordPerfect, and Lotus Notes.

2.4.2.4.2.3 Document Layout and Presentation

Netscape Navigator 2.0 provides extensive support for both HTML 2.0 and HTML 3.0.
The software supports backgrounds, font size, centering, blinking text, tables as well as
font color, transparencies, subscript, superscript text. Users can change the color of the
background, the text, unvisited links and visited links within the browser itself. The
hyperlinks are underlined which makes navigation simple. '

There is also extensive paragraph alignment controls and the ability to create multiple
panes on a single screen (frames). In addition, the user can control which frames are
reloaded and which ones contain persistent logos, advertisement, or other useful HTML.
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The software also supports a wide range of static and live objects ranging from
Macromedia Director to any OLE object.

The software also provides script support to glue objects and HTML together and give the
developer rich control over events.

2.4.2.4.3 Technical Features

2.4.2.4.3.1 General Performance Operability:

The newest release Netscape Navigator 2.0 offers new features, better performance in
terms of speed and a new level of inter-activity to users. It provides a platform for live on-
line applications, supporting Live Objects and other interactive multimedia content such as
Java Applets, frames, and Netscape inline plug-ins.

The software allows multiple, simultaneous loading of text and images, intelligent three-
level persistent caching and native progressive JPEG decompression allowing less than 10
percent of the image to be loaded before it’s recognizable. The new Progressive JPEG file
format loads images up to three times more quickly than the GIF format and provides
faster intermediate image recognition, so users on slow connections can view color-rich
images quickly.

Netscape also allows image maps to be interpreted locally without server intervention and
quick, seamless access to CD-ROM-based media. There is no native support for video,
but external applications can be used. It does offer full support of all World Wide Web
standards and inter-operability with most common network servers such as: HTTP,
Gopher, FTP, NNTP, SMTP, so you don’t need separate applications.

The Windows platform offers native AU and AIFF sound support, while all platforms have
native JPEG and GIF images support for graphics. The software works in any
environment that supports HTTP-compliant network clients, including Winsock. The
cross-platform development that guarantees a common interface and common behavior.

2.4.2.4.3.2 Electronic Mail (E-MAIL)

With version 2.0, Netscape offers full e-mail capabilities. Features include MIME
attachments for multimedia messages with automatic viewing, list, view, sort, and drag
and drop messages and off-line reading and sending. Mail can also be read or sent using
the POP3 and SMTP protocols, signatures viewed and personal address books created.
Mail security has been enhanced by using the Secure MIME (S/MIME) protocol for
encryption and digital signature.

Mail preferences can be selected from the Options menu in Netscape Navigator 2.0. To
setup preferences, users must supply server information (SMTP and POP3) in the blanks
provided. The personal information, such as name, company, and e-mail address can be
entered from the Options menu within the Preference menu. Mail can be accessed from the
file menu within version 2.0. This allows users to access their e-mail messages without
ever leaving the application.
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2.4.2.4.3.3 Security

Netscape Navigator 2.0 uses the open Secure Sockets Layer (SSL) protocol and RSA
encryption technology to enable commerce and secure communications on the Internet.
This multi-protocol security method is currently implemented to provide secure versions
HTTP to provide secure transfer of Web pages and on-line forms data. Netscape also
provides secure usenet news/conferencing capabilities via SSL support for NNTP. The
secure MIME (S/MIME) open protocol for encryption and digital signatures also allows
users to send and receive e-mail and newsgroup messages securely.

The SSL, which has been adopted by major Internet vendors and financial institutions,
provides server authentication, encryption and message integrity. Server authentication
verifies the identity of the server through a certificate and a digital signature. Encryption
ensures the privacy of client/server communications by encrypting the data stream
between the two entities. Message integrity verifies that the contents of a message arrives
at its destination in the same form as it was sent.

The Netscape Navigator has the ability to route SSL-based connections (HT TP or NNTP)
through proxy servers which are behind a firewall. A nice feature is that when you enter a
secure document over the Internet you will see a key lit up on the bottom leff corner of
the browser and for unsecured documents a broken key will appear.

2.4.2.4.3.4 Usenet News

Unlike the other Internet browsers, Netscape 2.0 offers full-fledged Newsgroups
capabilities by clicking on a button. The newsgroup feature allows users to sort and list
messages from subscribed folders and provides fully threaded, MIME-compliant news
reading and posting for multimedia news articles. With Navigator 2.0, users can even
embed Live Objects, URLSs, images, or HTML pages in their postings. The integrated
newsgroup feature supports multiple news servers.

The newsgroup preferences can be selected from the Options menu. To setup preferences,
users must supply server information in the blanks provided. The newsgroups can be
accessed from the File menu within Netscape Navigator 2.0. This allows users to access
their news postings without ever leaving the application.

2.4.2.4.4 Extensibility

Netscape allows a range of supported applications and viewers for enhancing Internet and
multimedia activities with additional software. It supports the following tools/applications
to be seamlessly built into it:

e SoftQuad Panorama SGML Viewer (Windows only)
e Acrobat Viewers

e MPEG Video Players

¢ QuickTime Video Players

e AVI Video Player
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e Windows Multimedia Player
¢ Postscript Viewers

e WHAM Audio player

e TIFF Image Viewers

2.4.2.4.5 Set-up and Installation

The set-up procedure for Netscape Navigator 2.0 is fairly simple. For Windows 3.1 and
3.11, the 16-bit version is required. For Windows NT and 95, the 32-bit version is
required. Compiled binaries are available for UNIX platforms. To install the browser on
Windows, double-click the Setup file. The Setup procedure will ask the user for the target
directory for the installation and prompt the user whether to continue the installation using
the previous netscape.ini file (from a previous installation).

2.4.2.4.6 Configuration Requirements

Configuration Requirement Information for Netscape Navigator 2.0

Windows 386SX 386SX 2MB SMB
Macintosh 68020 2MB SMB
UNIX N/A 3MB 16MB

Intel (x86) based:
e  Windows 3.1
e  Windows for Workgroups 3.11
e Windows 95
e Windows NT
Apple Macintosh:
e Macintosh System 7
e MacOS
e PowerPC

e Digital Equipment Corp. Alpha (OSF/1 2.0)
o Hewlett-Packard 700-series (HP-UX 9.03)
e IBM RS/6000 AIX 3.2
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¢ Silicon Graphics (IRIX 5.2)
e Sun SPARC (Solaris 2.3, SunOS 4.1.3)
e 386/486/Pentium (BSDI)

2.4.2.4.7 Cost and Maintenance
Netscape only offers client-based licenses. No site or concurrent licenses are available.

Netscape Navigator 2.0 for Windows, Macintosh and UNIX-based systems is $49.00 per
license. The table below lists the discount prices.

Cost Information for Netscape Navigator 2.0

1-9 $49.00
10-249 $41.46
250-499 $33.92

500+ Will Quote Cost

Netscape offers two different types of maintenance support. The first is for subscription
upgrades to software for $17.00 per year per license. Support maintenance (phone and e-
mail) is available for $6.29 per license, with a minimum of $500 in support maintenance
purchased.

2.5 Targeted Issue Analysis for Information Standards

The “Targeted Issue Analysis for Information Standards” portion of this task is presented
as a high level survey of a selected group of topics that are supplementary to the main task
of evaluating SGML/HTML tools for use on the Intelink. The question that this study
addressed is “Does this issue support further study?” On each issue we have provided
general comments and a recommendation as to whether further study on that topic is
warranted. The issues provided are difficult to address in a mid-level undertaking and the
client must decide, based on this and other available information, whether the topic merits
further study.

e What conversion tools should be recommended for mapping one document to
another?

In order to make a qualified recommendation for conversion tools to map one document
to another there needs to be a detailed analysis of the Intelink documents. This analysis
would be designed to determine the structure and characteristics of the document types.

A detailed document analysis is beyond the scope of this task, and therefore a conversion
tool is not recommended. Additional work on this matter should be performed in separate
follow-on tasks.
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e How are data elements for C3I similar to and different from those in SGML,
i.e. how does C3I tie into Intelink?

The major initiatives in the C31 community are the Global Command and Control System
(GCCS) and C4I for the Warrior. Much of what was originally envisioned for the C4I for
the Warrior has been incorporated into-the GCCS. The technical specifications for the
data elements for GCCS are not available to us for this project. However, the strategic
and tactical use of intelligence information is one of the keys to offset the declining US
force structure. It is therefore imperative to success on the battlefield that the US armed
forces information advantage be improved.. This situation leads to the immediate
integration of intelligence in the end-to-end C3I — the creation of information directly to
the tactical commander. The drastic and rapid changes taking place in the revolution of
information warfare emphasize the crucial nature of integration of Intelink information
into C3L.

The Congressional oversight committees and the Secretary of Defense are committed to
merging C31 information from the source to the warfighter. By combining the national
foreign intelligence program with tactical intelligence and associated areas they hope to
leverage the power of the intelligence that is available as a major force multiplier.
Emphasis for intelligence information rests on joint and combined operations, with
national intelligence playing a crucial role. It is ultimately envisioned that national
intelligence would feed via a global command and control system to the joint task force to
provide command, control, communications and intelligence (C3I) for the warrior through
distributed ground stations.

Due to the changes in the nature of modern combat, the integration of intelligence is
critical to success in information-based warfare. Mobile and relocatable targets create
intelligence requirements to meet stringent timelines. For example, national level assets
may be used for the tactical targeting of a weapon system such as a Scud. Targeting for
weapons such as a Scud requires the rapid input of intelligence information, which also
rests on effective communications.

The above discussion highlights the need for early discussion between the GCCS planners
and the Intelink planners in order to ensure that the systems are compatible and that they
can interchange data.

e What are the Intel Community’s requirements for compression standards to
work on the Intelink?

The Intel community can provide a much greater service to the warfighters if they can
provide highly compressed data. Many of the higher level customers of the intelligence
community have access to intelligence data through high bandwidth channels. This high
bandwidth is usually available at the “wholesale” level of intelligence. The end users at
the “retail” level do not have access at high bandwidth and may have only 56 kbps access
or less. The real question is throughput.

Throughput is a function of document size, bandwidth of transmission channel, and

compression. The requirement is to move the document to the end user in a “reasonable”
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amount of time. For the end users with lower bandwidth access the benefit of efficient
compression is magnified.

e What is the future of graphics in the commercial market for use on the
Internet?

There are several issues that need to be considered when evaluating the future of graphics
on the Internet. First of all, there needs to be “viewer” or “interpreter” capability for the
graphics data to be viewed. This may be some sort of run time version of an image
software executable or a translator to filter in the data needed to view the file. These
viewers should be capable of importing various different file formats of graphics images.
The second issue concerns the graphics (files) themselves. Compatible file formats with
the viewers are essential for any type of visual representation of the data. The graphics
also need to be easily accessible to the viewer or translator. The files (images or graphics)
may be linked to a particular directory or remote location. Direct access to the data will
increase potential of interpretation of the data from the file.

The third major issue would be the speed at which the image can be visually represented.
This may depend on the viewers capability, the speed of your transmission
(communication baud rate) and the type of file format that the data is saved. For example,
a raster image of a picture usually requires a huge amount of memory compared to a
vector image of the same picture. Compression techniques may be extremely time
consuming and cumbersome to use. There may also be various layers of the graphic that
will require time to display the data. The ability of dynamic execution of the viewer
executable file also contributes to the delivery speed of the image.

e What are the implications of a secure MOSAIC for Intelink users?

Secure MOSAIC is not “secure” in the sense of security classification. Secure MOSAIC
is designed to accommodate commerce (i.e. the use of credit cards) on the Internet and
the World Wide Web. Although secure MOSAIC is promising for the prevention of
consumer fraud, it is a long way from providing the type of security required to operate in
“secure” environment. The very nature and intent of the Internet is an open access to
data and information. This openness is the main reason that a separate Internet system,
the Intelink, was created. Secure MOSAIC will not overcome the openness of the
underlying Internet style architecture of the Intelink; however, the intelligence community
should stay abreast of future developments in this area.

e What are the legal requirements for Freedom of Information and the impact of
these requirements on Intelink?

The advent of electronic documents and hypermedia present some new and interesting
wrinkles for the Freedom of Information Act (FOIA). FOIA was written before electronic
publishing became a reality and therefore there are many issues of the use of FOIA in
“cyberspace” that are now open to interpretation. The generally accepted practice in this
domain has been to follow the precedent set in the paper media.

SGML and the electronic publishing environments may be used to preselect information
that is provided via FOIA requests. The SGML attributes can be set and arranged in such
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a manner as to facilitate the protection of sensitive non-FOIA applicable information,
while at the same time allowing quick turnaround to FOIA requests.

The use of SGML and electronic publishing may, with some forethought, be used to ease
the administrative burden of FOIA and provide greater assurances that sensitive
information is not inadvertently compromised.

e What work has already started in the Internet community using Hypertext
Markup Language (HTML) to add audio and full-motion video to a network
hypertext document that uses HY TIME concepts and principles?

Until now no work has been done by the HTML community to use HYTIME concepts
and principles. As far as adding audio and video to HTML documents, it depends more
on the client than on HTML. The concept of live and on-demand audio/video over the
Internet and local area networks is being used to transmit and receive a continuous video
and audio stream. At least two server products (Real Audio from Progressive Networks,
and Stream Works from Xing Technologies) are available which support the transmission
of continuous video and audio stream playout from a server on the Internet. An example
of a client product available that can be configured as a viewer within the WWW browser
to play live and on-demand audio/video over the Internet is Xing MPEG from Xing
Technologies. If properly configured with one of these or a similar product, a hyperlink
within an HTML document can provide near-real-time audio and video over the WWW.
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3. CONCLUSIONS AND RECOMMENDATIONS

The nature of the tasks contained in this project are such that they provide the necessary
information for the client/decision maker to make informed decisions concerning the use
of HTML and SGML tools in a variety of end-user oriented applications. As such, the
majority of the direct conclusions that can be drawn from the work are the results of the
reviews of the products. These results are given in the below listed tables, which are to be

found in Chapter 2:

e Summary of Evaluations of SGML Editors

e Summary of Evaluations of HTML Editors

e Summary of Evaluations of SGML Viewers
e Summary of Evaluations of HTML Browsers

However, two other indirect conclusions from this work can be determined. First, the
importance of developing a precise and repeatable evaluation of the products under review
cannot be overestimated. As the number of products increases beyond the capacity for
one single individual to perform effectively, we confirmed the requirement to develop a
solid foundation of evaluation criteria for the products. As we continued the work on the
products, these criteria became candidates for change. However, the development of
these criteria early on in the project laid the foundation for conducting not only these
evaluations, but also for any future evaluations that the client may require.

Second, the participants in this project found that time and again, especially with regards
to HTML, the notion of a stable standard is still somewhat of a notion for the future,
rather than the present. The standards that are in place today have in many cases been
determined to be inappropriate in view of the explosive growth of the World Wide Web,
and are in the process of being changed. However, for a variety of reasons that appear to
be both technical and political, the standards and even the proposed standards seem to be
changing at least weekly. In fact, some vendors have taken the necessary steps to put into
place capabilities within their products that would allow customers to download changes
to the product that would keep the product current as to proposed standards. All of this
leads to the following conclusion — If a strict adherence to firmly established standards is
required before the client will consider purchasing an HTML product(s), then accept that
this may be the same as deciding not to purchase any product in the near future. It is our
opinion that standards development in the HTML community will be a continuing issue for
the foreseeable future, as technology combines with user requirements and marketplace
realities to form an unstable standards environment.




GLOSSARY

Anchors

ANSI

Attribute

Auto-tagging

Browser

CALS
CBT
Check boxes

DSSSL

DTD

Dynamic application

Editor

Elements

Encryption

Firewall

A pointer object in an HTML document that points to
another document, or specific location in another or the
same document.

American National Standards Institute. An organization
for developing and distributing national standards on a
variety of subjects.

A qualifier indicating a certain property of a given textual
element, other than its type or content.

The ability to take documents created in a word
processing system and appropriately tag it in SGML or
HTML formats.

A program that is utilized over the World Wide Web to
retrieve and display documents from a WWW server.

Continuous Acquisition and Life-cycle Support
Computer Based Training

Used in HTML to designate a Yes/No choice between or
among items.

Document Style and Semantics and Specification
Language. An ISO standard related to specification of
layout and composition in a manner that is independent
of particular formatting systems or processes.

Document Type Definitions. The definition of the
markup rules for a given class of documents.

A dynamic application is one that can be operated by a
system not running on the same server via the Internet.

A program used to create documents, used here to
describe those documents within SGML and HTML.

The basic building blocks of HTML and SGML
documents.

The process of altering data so that it is not capable of
being understood except by those possessing the
encryption key.

A computer or computer system that prevents
unauthorized access to networks through one of the
attached computers.




FOSI

GIF

Gopher

GUI
HTML

HTTP

Hypertext
HYTIME

Invalid element

JPEG

Mailto
Markup

MIME

NCSA
NNTP
OLE

Parser

Formatting Output Specification Instance. The IGES
standard for engineering, product design, and
manufacturing drawings is one of the CALS standard
graphics formats.

File Transfer Protocol, allows a user to pick up a copy of
a file from a remote computer, and can be specified in a
URL.

One of the graphic format used in HTML and SGML
languages.

An Internet protocol compatible with most HTML
servers.

Graphical User Interface

HyperText Markup Language. The format for
publishing documents on the World Wide Web. HTML
is an application of SGML. Currently, HTML v 3.0 is
being developed.

HyperText Transfer Protocol, used to transfer HTML
documents over the World Wide Web, between a server
and a browser.

Text that is linked to other text or documents.
Hypermedia/Time-based Structuring Language

In element in SGML /HTML is in a position where the
element cannot exist is an invalid element.

One of the graphic format used in HTML and SGML
languages.

A capability to send email from within a browser.

Anything added to the content of a document that
describes the text.

Multipurpose Internet Mail Extensions, which allows
email to contain audio, video, and multiple file
attachments, and which is the format used by the WWW
to transfer files.

National Center for Supercomputing Applications.
NetNews Transfer Protocol

Object Linking and Embedding. A standard for including
data from one file in another without actually copying
and pasting the data.

A specialized program that recognizes SGML markup in




PDES/STEP

POP3

Proxy servers

SGML

SMTP

Stylesheet

Tag
TCP/IP

Template

Text
URL

Visited links

WWW (the web)

WYSIWYG

a document,

Product Data Exchange Standard/Standard for the
Exchange of Product Model data. Standards for
communicating a complete product model with sufficient
information content that advanced CAD/CAM
applications can interpret.

Post Office Protocol

An application on a firewall server designed to continue
the protection of the firewall while allowing access to
WWW from within the protected network.

Standard Generalized Markup Language, an international
standard for describing the markup or format of
documents.

Simplified Mail Transfer Protocol. An email format for
the Internet.

A collection of formatting instructions for a given text
element.

A symbol delimiting a logical element inside a document.

Transmission Control Protocol/Internet Protocol, a low-
level protocol used on the Internet.

A set of commands which will help a user create
documents of a certain type.

Data composed of characters and words.

Uniform Resource Locator, is the address of a file, in a
format usable by a WWW server that can then retrieve
the file.

Links that you have viewed previously on the Internet.

World Wide Web, abbreviated as WWW or “the web,”
a worldwide collection of Web servers and browsers.

“What You See Is What You Get”
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